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Important User
Information

Because of the variety of usesfor the products described in this pulication,
those resporsible for the appli cation and wse of this control equipment must
satisfy themselvesthat all necessary steps have been taken to asaure that
ead applicationand wse medsall performanceand safety requirements,
including any appli cable laws, regulations, codes and standards.

Theill ustrations, charts, sample programsand layout examples shown in
this guide areintended solely for purposes of example. Sincethereare
many variables and requirements associated with any particularinstall ation,
Allen-Bradley does nat assume resporsibility or liability (to include
intellecual property liability) for adual use based uponthe examples shown
in this pulication.

Allen-Bradley pulication SGI-1.1, Sdety Guidelines for the Application,
Installation, andMaintenance of Sdid-Sate Control (avail able from your
locd Allen-Bradley office), describes someimportant differences between
soli d-state equipment and eledromechanica devices that shoud be taken
into consideraion when applying products such as those described in this
pubication.

Reproduction o the contents of this copyrighted puldicaion,inwhole or in
part, withou written pemrmisson d Allen-Bradley Company, Inc., is
prohibited.

Throughou this manual we use nates to make you awareof safety
consideraions:

ATTENTION: Identifiesinformation about pradices
or circumstances that can lead to persona injury or
deah, property damage or econamic loss

Attention statements help youto:
W identify ahazad

W avoid the hazad

W recognzethe consequences

Important:  Identifiesinformation that is criticd for successul
application and uncerstanding d the product.

PanelBuil der, PanelView, Data Highway Plus, ControlNet, DH+, ControlLogix, and
SLC aretrademarks, and PLC, PLC-2, and PLC-3 areregisteral trademarks of
Allen-Bradley Company, Inc.

RSViewis atrademark of Rockwell Software Inc.

IBM, PC, PS2,VGA, and PG-DOS areregistered trademarks of Intemational Business
Machines Corporation.

Epsonis aregisterad trademark of Seiko Epson Corporation.

HP and Hewlett-Padkard areregistered trademarks of Hewlett-Pad<ard Company

Mi crosoft, Windaws, MS, and MS-DOS areregistered trademarks of Microsoft Corporation.
AutoCAD is aregistered trademark of Autodesk Inc.

All other brand and product names aretrademarks of their respedive companies

and are hereby adknowledged.
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Preface

OmOn
Welcome to PanelBuilder Welcome to Allen-Bradley’s PanelBuil der] 140G Corfiguration
1400e Configuration Softwarefor Windows, Version 5.The CD-ROM contains Version 5
Software for Windows and Version 3softwarefor creaing appli caions in the Mi crosoft [

Windows[ 3.1(or later), Windows 95,and Windows NT 4.0
operaing systems You run the PanelB uil der applicaions on
PanelView] 100Qe, 120@, or 140@ temrminals, or PanelView 1200
Series F and later terminals that have been enhanced to -MC cataog
numbers.

PanelBuil der 140G Configuration Softwarefor Windows, Version 5,
provides the advantages, as well as other enhancements, that
PanelBuilder 140@g, Version 4, dfered. These include:

W suppat for ControlNet 1.5 Scheduled Mode communicéaions

Numeric and ASCI Inpu objed suppat for extemal keyboard
and kar code reader inputs

W suppat for A-B Dataliner message display compatibility
high resolution suppat for 800y 600screens for the
PanelView 140Ce terminal

W suppat for additional HP[ laser printer compatibilit y

increased number of alam messages and enhanced alam history
suppat for Acknowledge All, ClearAll, and Home/End feaures

increased number of alam history records
increased number of locd and information messages

W suppat for the Logix55xx Processors communicaing in
ControlLogix Legacy mode

w enhanced addressing for fil e transfers over networks using
ControlLogix bridge addressing

W suppat for additional smallerfont sizes

W suppat for viewing manuals online from you PanelBuil der
application

w direa placanent of objeds to spedfic x,y coordinates

W snap-to feaure for line ojeds

w mostrecantly used list records upto four applicaions

For amore comprehensive description d ead of these feaures, see

“What's New in PanelBuilder 140@, Version 5’ in Chapter 1,
“I ntroducing PanelBuilder.”
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Registering Your Copy of
PanelBuilder 1400e

Available Documentation
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To register you software mail the registration cad to this address:

Rockwell Software
SoftwareSewices

6680Beta Drive

Mayfield Vill age, Ohio 44143

or fax the card to (440) 6467701.

Your PanelB uil der 140 softwarecomes with severd types of
documentationto med your different neals:

W Getting Sarted with PanelBuilder 140G Configuration Sdtware
for Windows (A-B Publicaion Number 2711E-6.13 guides you
throughsetting upPanelB uil der 1400 and introduces you to
PanelBuil der 140Ce basics. It includes atutorial to gve you
hands-on experiencein creding and runring a sample
application.

W The ParelBuilder 140G Configuration Sdtware for Windows
User Manud (A-B Publication Number 2711E-6.14) explains
PanelBuil der 140Ce in more detail, and provides step-by-step
instructions for planning, creding, and working with appli caions.

W The ParelBuilder 140G Configuration Sdtware for Windows
Rderence Manud (A-B Publicaion Number 2711E-6.15
provides detail ed referenceinformation for appli cation screen
objeds.

W The PanelView e Transfer Utility User Manud (A-B Publicaion
Number 2711E-6.16) provides detail ed instructions for
transferring appli caion files using the Transfer Utility that comes
with PanelBuilder 140@, Version 5.

W The PanelView 100G, 120G, and 140@ Operator Terminals
User Manud (A-B Publicaion Number 2711E-6.17) describes
how to install, configure, maintain, and troudeshoa the
PanelView temminal.

W The ParelBuilder 140G Configuration Sdtware for Windows
Modbuws User Manud (A-B Publication Number 2711E-6.12)
describes how to crede PanelBuil der applications for the Modbus
communicaions network. This manual is suppied as part of the
optional Modbus Communications Kit, A-B Catalog Number
2711E-UMOD.

w Context-sensitive Help provides a quick referancefor any
procedures or commands you reed explained, o problemsyou
may encourter. To get help, pressri or chocse the Help butonif
youre in adialog box.

W The ParelBuilder 140G Readmefile is a Microsoft Windows
Notepad fil e that is copied to you hard dsk when youinstall
PanelBuil der 140C. The Readmefileinformsyou d any
software changes after the manuals were printed.
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What's in Getting Started ?

A complete list of pulicdionsrelatingto PanelBuil der 140G,
PanelView teminals, and programmeable logic controllers (PLCs) is
avail able in the prefaceof the PanelBuilder 140@ Configuration
Sdtware for Windovs User Manud.

Getting Sarted introduces basic concepts for working with
PanelBuil der 140G Configuration Softwarefor Windows. This
manual is divided into two parts. The first part introduces youto
PanelBuil der 140 and explains the basics for working with it. The
send part contains a tutorial that gudes you throughenhancing an
existing application, and running it onthe PanelView temminal.

Preface

An owernview of this manual, and lists of prereguisites, documentation
conventions, and related pulications.

Chapter 1, Introducing PanelBuilder 1400e

An introduction to what PanelBuilder 140Qe s, what it does, and
how it works with PanelView terminals and the PLC.

Chapter 2, Installing and Starting PanelBuilder 1400e

Step-by-step instructions for instlli ng and starting
PanelBuilder 140Ce.

Chapter 3, Installing and Starting the PanelView e Transfer Utility

Step-by-step instructions for installi ng and starting the Panel View e
Transfer Utility.

Chapter 4, Installing and Starting the PanelView Serial Firmware
Upgrade Utility

Step-by-step instructions for installi ng and starting the Panel View
Seria FirmwareUpgrade Utility.

Chapter 5, A Brief Tour of PanelBuilder 1400e

An owerview of the PanelBuil der 140@ devel opment environment,
comporents, and key concepts.
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Chapters 6 to 11, The Tutorial

Thetutorial is atask-oriented gude to enhancing andrunninga
sample applicaion. Chapter 6 provides atour of the sample
applicaion: what it is, what it does, and hav youwill enhancethe
application. Chapters 7 through 10 povide step-by-step instructions
for adding oheds and messages. Chapter 11 tells you hav to
download and run the appli cation.

Who Should Read Getting Started?

Geting Sarted provides a comprehensive overview of PanelBuil der
140G basics. Depending on you needs and previous knowledge,
cettain sedions may be more useful to youthan ahers.

If this desc ribes you Read this
Unfamiliar with both PanelBuilder 1400e and Windows  Getting Started, Chapters 1, 2,
and 5
Windows user documentation
Familiar with PanelBuilder 1400e and want to know Getting Started, Chapter 1
new features of PanelBuilder 1400e, Version 5
Want to know how to install and start PanelBuilder Getting Started, Chapter 2
1400e
Want to know how to install and start PanelView e Getting Started, Chapter 3

Transfer Utility

Want to know how to install and start PanelView Serial ~ Getting Started, Chapter 4
Firmware Upgrade Utility

Want step-by-step guidelines to working in Getting Started, Chapters 6
PanelBuilder 1400e to 11

Want to know how a PanelBuilder 1400e application Getting Started, Chapter 11*
runs in a PanelView terminal

*You can run the tutorial application without having to create it first.

Userswho arenat familiar with Microsoft Windows shoud read the
Microsoft WindowvsUser’s Guide (for users of Windows 3.1),
Introducing Microsoft Windows 95 (for users of Windows 95), or
Introducing Microsoft Windows NT Workstation (for users of
Windows NT).
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Terminology

Conventions Used

The term Panel Buil der refers to PanelBuil der 140G Configuration
Software for Windows. Whereconfusion may arise between the
current and previous versions of the software the current release of
the softwareis “PanelBuilder 140, Version 5”7

Similally, the tertmsterminal and Panel View terminal referto a
PanelView 100G, 120G, or 140G terminal, or enhanced Panel View
1200Series F and G teminals. Whereconfusion may arise between
the 120G and 140@ teminals and previous revisions, spedfic series
and revision nrames areused.

The termsprogrammable controller and PLC referto the
Allen-Bradley line of Programmable Logic Cortrollers or any ather
controlling cevice

PanelBuilder User Manud refers to the Panel Buil der 140G
Configuration Sdtware for Windowvs User Manud. Panel Buil der
Rderence Manud refers to the Panel Buil der 140@ Configuration
Sdtware for Windows Reeerence Manud. Other user manuals are
referred to bytheir full names.

Information is provided in a consisent way throughou the entire
PanelBuil der user documentation set. Therearemouse seledion,
shortcut key, and command conventions. Unlessotherwise stated, all
dialog boxes and windows arecaptured in Windows NT.

Mouse Conventions

You can use amouse with ore or two butons. This manual assumes
that if you have a multi ple-utton mouse, the left mouse buttonis
configured as the primary mouse button. Procedures that require you
to click a secondary button referto it as the right mouse button.

Selection Conventions

This word or phrase Means

Choose Carry out a menu command or a command button in a dialog
box or Help window. Choose also means to double-click an
icon.

Choose OK Either click the OK button with the mouse or press ENTER
on the keyboard to carry out the action.

Select Either highlight the piece of text you want your next action to
affect, or select a specific dialog box option.

Click Position the mouse pointer on the object, area, or field, and
click the left button once.

Double-click Position the mouse pointer on the object, area, or field, and
click twice quickly.

Publication 2711E-6.13 — November 1998



P-6 Preface

Publication 2711E-6.13 — November 1998

Selection Conventionsin Dialog Boxes

Diaog boyes contain standard Windows fields that require different
seledion conventions. Referto you Windows user documentation
for information onthe seledion conventions.

The following shortcut keys allow youto complete dialog boyes
faster:

This key or key Does this

combination

TAB Moves the cursor to the next field, option, or command
button.

SHIFT+TAB Moves the cursor to the previous field, option, or command
button.

ALT+underlined letter Selects an option, or displays a drop-down list.

ALT+ Displays a drop-down list.

SPACEBAR Turns check boxes on or off.

Key Conventions

This key combination Means

KEY1+KEY2 Press and hold the first key while you press the second
key. For example, press “CTRL+A" means to press the
CTRL key, and while pressing it, press the A key. Then
release both keys.

SHIFT-click Press and hold the SHIFT key while you click an object
with the mouse pointer.

Command Conventions

Use any o the foll owing threemethods to carry out commands.
Instructions in this manual do nd always outli ne ead method.

W choase a menu command
W choose anicon onthe todbar
W useakey combination

For example:

Use any of these commands to open an application

Choose Open Application from the File menu.

Click =1 from the toolbar.
=

Press CTRL+O.
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Before You Begin

Technical Support
Services

Before you hegin, youshoud arealy have instaled and knav how
to operde this equipment and software

W apersona computerwith at leasta 486, 25MHz microprocessor;
at leasst 8-MB Randam AccessMemory (RAM) (16-MB RAM
recommended); and a SVGA monitor with 256colors
(recommended). For users working with imported .dX files, at
least 16-MB RAM is required.

Note: Windows 3.1and 95require aminimum of 8 MB RAM

athough 16MB arehighly recommended. Windows NT requires
aminimum of 32-MB RAM to run succesdully.

If youwant to resize graphic images in PanelBuil der, set your
display adapterto at least 65,536colors.

W Microsoft Windows 3.1 operding system or later, Windows 95, o
Windowvs NT

w the family of PLCsyouwill be monitoring and controlling

If you have questions about PanelBuil der, please consult the manuals
or online help first If youcanna find the answer, take advantage of
our Technicd Suppat Fax Bad system, avail able 24 hous a day, 7
daysaweek at 1-440-646-6701, @ browse through ou technicd
suppat document library at
http://www.ab.com/mem/technotes’kbhome.htmi

on the World Wide Web.

Altematively, contad:

Rockwell Automation

Technicd Suppat

1 Allen Bradley Drive

Mayfield Heights, Ohio 441246118

or cdl 1-440646-6800 o fax 1-440-646-7801for technicd suppat
between 8am and 5pm (EST), Monday to Friday.

Please have the seria number for your softwareready when youcal,
or include it on you fax. You can find this number.

w onthe SoftwareRegistration cad that was shipped with your
software

W onthe screen that appears when youstart PanelBuil der
in the main Help menu, when youchocse Abou
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Chipter 1

About PanelBuilder 1400e

PanelBuilder, PanelView
Terminals, and the PLC

Introducing PanelBuilder
1400e

This chapter provides an owerview of PanelBuilder 140@. It covers
these topics:

W what PanelBuilderis

w how PanelBuilderinterads with the Panel View temminal and the
PLC

W important new PanelB uil der feaures

PanelBuilder 140(e is a software padkage that runs on Mi crosoft
Windows 3.1 a later, Windows 95, a Windowns NT 4.0.With
PanelBuilder 140G you crede and design control panel applicaions
for PanelView operaor teminals.

These control panel applications enable an operaor to monitor and
control automated plant proces<s.

The relationship between PanelBuil der, the Panel View temminal, and
the PLC is asfollows:

w PanelBuilder—The applicationis creded in PanelBuil der onthe
development computer, and davnloaded to the PanelView
terminal using the Transfer Utility.

w Programmable L ogic Controller—When communicaing owera
Remote |/0O, Data Highway Plus (DH+), or Control Net network,
the PLC can eitherrespondto queries or solicit information from
the PanelView temminal and aherinpu or output devices.

w PanelView terminal—The Panel View terminal displays the
processstatus information sent from the PLC. This information
enables the operaor to make dedsions abou the process The
operaor providesinput bad to the PLC.

Note: To crede applicaionfil es, the development computer does
not need to be conreded to the PLC or the Panel Viewteminal. The
computer must be conneded oy when youaredownloading o
uploading the application serialy or overthe PLC communications
network. You can aso install the PanelView e Transfer Utility 32 on
a portable computer, transfer the appli cation to the partable
computer, and then udoad or download the appli caion from the
portable computer. Seethe PanelView e Transfer Utility User
Manud for details.
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PanelBuilder
1400e Software
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PanelBuilder 1400e

PanelB uil der is the devel opment software padage you seto crede
and configure control panel application screans. Applicaions

devel oped with PanelBuil der software ona computer are
downloaded to Panel View terminals wherethey arerun.

Development
Computer

PanelBuilder
Hove

PanelView O perator Terminals

The following terminals will run PanelBuil der 140Qe applications:

w PanelView 100G teminals, Series A and later, running Version 3
or later firmware

w PanelView 1200Series F and | ater terminals that have been
enhanced with a PanelView 1200Enhancement Kit (A-B Catalog
Number 2711E-U1B12C), and arerunring Version 1 a later
firmware

w PanelView 120G teminals, Series A and abowve, runring Version 1
or later firmware

w PanelView 140G teminals, Series A and abowve, runring Version 1
or later firmware

Note: All other PanelView 1200teminals will run orly applicaions
creded in PanelBuilder DOS (A-B Catalog Number 271:ND1) or
PanelB uil der 1200(A-B Catalog Number 2712ND1W). They will
not run PanelBuilder 140Q: applicaions.

Note: To communicéae over a ControlNet network, youmust use a
PanelView 100@ or 140G terminal that has been upgaded to
include an ISA Card Adapter (A-B Catalog Number 2711E-NA1 or
2711E-NA2) anda 1784KTCS 1784KTCX or 1784KTCX15
card. Or you can use the new Panel View 140G temrminals that
suppat ControlNet communicaions (A-B Catalog Numbers
2711E-K14C7, 271E-K14C15, 271E-T14C7, 271E-T14C15), or
the new PanelView 100@: terminals that suppat Control Net
communicaions (A-B Catalog Numbers 2711E-K10C7,
2711E-K10C15, 271E-T10C7, 271E-T10C15). These terminals
arerealy to use with you ControlNet network.
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PanelView 1000e
Terminals

PanelView 1200e
Terminals

PanelView 1400e
Terminals

The application screans creded in PanelB uil der appearonthe
Panel View terminal, repladng traditional hard-wired control panels.
The screens provide the physicd interfacebetween the PLC and the
human operaor.

Applicaion screens contain oljeds that function like control panel
comporents. By using these objeds to enter data or carry out
commands, the operaor can monitor and control the process

Touch Screen Terminals Keypad Terminals

B8 Aen-Bradrey

& Atten-Bradiey

- Y—

PanelView 1000e

@B Atten-Bradrey

Fl F2 F3 F4 F5 F6 F7 F8

PaneiView 1200e Fo Fl0 F11 Fi2 Fi3 F14 Fi5 Fi6

PaneiView 1400e A;l::l Allen-Bradiey PaneiView 1400e

F9 FI0 F11 F12 F18 Fi4 FI5 F16
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Programmable Logic
Controller
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Programmable Logic Controller

When communicating over a Remote |/O, DH+, or ControlNet
network, the PLC can either respondto queries or solicit information
from the PanelView teminal and aherinpu or output devices.

el

@

(-]

000
000

[

23737

The PanelView teminal is conreded to aPLC in ore of the

following ways:

w Remote I/O link—The PanelView terminal is conreded to a
single controll er. The controll er sends processinformation, such
as messages, numelic data, or alames, to the teminal. The
controller also soli cits the Panel View terminal for operaor inpu.

DH+—The PanelViewteminal is conneded to a peerto-peer
DH+ network that includes multi ple controll ers and aher devices.
The temminal can control and monitor addresses in these devices
onthe network.

ControlNet—The PanelViewteminal is conreded to a
peerio-peerControlNet network. The temrminal can control and
monitor addresses in these devices onthe network.

IS

1S

The PanelView termina can optionally be conneded asa deviceto a
Modbus network. For more information abou using Panel View
teminals with Modbus, seethe PanelBuil der 1400 Configuration
Sdtware for Windows Modbus User Manud (A-B Publication
Number 2711E-6.12).
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Understanding the Different Network Types

Therelationship between the Panel View terminal andthe PLC
depends onwhether the teminal is part of a Remote 1/0, DH+, or
ControlNet network. The following ill ustration shows the
relationship between PanelB uil der, the Panel View teminal, and the
PLC.

In this example, the PanelViewteminal is conrneded by
Remote 1/O.

The application is created in PanelBuilder on the
development computer and downloaded to the
PanelView operator terminal.

The PLC receives information from the PanelView terminal (input), and uses this to
I I control the machine or process.
== The PLC also sends process status information to the terminal (output).

Development Compute r

Serial Connection Remote I/O
Remote 1/0
-
<—————  Programmable -

Logic Controller
Machine or Process

& Allen-B radley PanelView 1200e

PanelView 1000e/1200e/1400e Terminal (Touch Screen)

" Tip: For conredion dagrams, seeFigures 2.1through 2.10n
Chapter 2, “Working with the PanelView e Transfer Utility 32" in
the PanelView e Transfer Utility User Manud.
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In theill ustration below, the PanelView temminals areconneded over

DH+.
The application is created in PanelBuilder on the
development computer and downloaded to the
PanelView operator terminal.
1 1
S
Development Computer

Serial Connection

Allen-Bradley PanelView 1200 € = Allen—Bradley PanelView 1200 e
The PanelView terminal queries PanelView 1000e/1200e/1400e PanelView 1000e/1200e/1400e
the PLC for process or machine Terminal Terminal
status information. (Touch Screen) (Touch Screen)
Operator input to the terminal is Data Highway Plus

sent to the PLC. The PLC uses this
information to control the machine
Or process.

Programmable Programmable
Controller Controller
Machine or Machine or -
Process Process
" Tip: For conredion dagrams, seeFigures 2.1through 2.10n

Chapter 2, “Working with the PanelView e Transfer Utility 32" in
the PanelView e Transfer Utility User Manud.

Publication 2711E-6.13 — November 1998



Introducing PanelBuilder 1400e 1-7

The PanelView terminal queries
the PLC for process or machine
status information.

Operator input to the terminal is
sent to the PLC. The PLC uses this
information to control the machine
Or process.

In theill ustration kelow, the Panel View temminals areconreded by a
ControlNet network.

The application is created in PanelBuilder on the
development computer and downloaded to the
PanelView operator terminal.

Development Computer

Serial Connection

ControlNet PanelView 1000e ControlNet PanelView 1000e
or 1400e Terminal or 1400e Terminal
(Touch Screen) (Touch Screen)

ControlNet

Programmable Programmable
Controller Controller
Machine or Machine or -
Process Process

" Tip: For conredion dagrams, seeFigures 2.1through 2.10n
Chapter 2, “Working with the PanelView e Transfer Utility 32" in
the PanelView e Transfer Utility User Manud.
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What's New in
PanelBuilder
1400e Version 5
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PanelBuil der 140Ce, Version 5, povides expanded hardwaresuppat
to allow youto crede applicaions for awider variety of
environments, terminals, and retworks.

ControlNet 1.5 Scheduled Mode Operation

PanelBuil der 140@, Version 5,can naw use the deteministic portion
of Allen-Bradley’s ControlNet 1.5 retwork where Scheduled
time-ciitica datais given a higher priority over the nontime-ciiticd
Unscheduled data. ControlNet appli caions have been enhanced to
allow communications in urscheduled mode and scheduled mode.
Using RS\etworx, youcan configure the rate at which scheduled
information is broadcast over ControlNet and which stations areto
listen to this information.

Keyboard and Bar Code Reader Suppo rt

With PanelView firmware Version 5, youcan enter values using an
extemal keyboard and/or bar code reader conreded to the
PanelView's keyboard pat. The keyboard and/or bar code reader can
also be used with the PanelViewtouch screen o keypad terminal.

RS232 Alarm Message Output to Dataliners

Panel View firmware Version 5,suppats alarm message output to
A-B Dataliner models DL 10 (A-B Catalog Number 2706 A41J),
DL20 (A-B Catalog Number 2706B21J), and DL50 (A-B Catalog
Number 2706 F11J) viathe Panel View R232 pat.

VGA and SVGA Applications

Panel View Firmware Version 5,suppats a Panel View 140G
applicationwith a screen resolution o 800y 600 o 640 x 480.
PanelB uil der 140Ce can convett an appli caion screen from a higher
to alowerresolution a vice versaand can automaticaly scde the
onscrean application.

Enhanced PanelView Pri nter Suppo rt

Panel View firmware Version 5,suppats HP LaserJet-compatible
printers, in addition to the currently suppated Epson-compatible
printers. Additionally, Portrait/Landscgpe and 8.5y 11inch/A4 paper
printingis suppated.
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Enhanced Alarms

PanelView firmware Version 5, nav suppats 4,000alamrm messages
and 2,500alam history records. Aswell, the Alamrm History screen
alows: alatmm messages to be sorted bytime or by trigger value;
quick scrolli ng throughthe alam messages with the addition o new
aams hame, and end butons; adknowledging all alaTmswith an
adknowledge all button; and cleaing all alatmsout of the alam
history with a clearal button a the alamm history upload ogtion. The
alam status screen aso feaures the new home and end butons that
enable quick scrolli ng throughalam messages.

More Local and Information Messages

Panel View firmware Version 5, nav suppats 10,000locd messages
and 10,000 nformation messages.

Log ix55xx Pr ocessors

PanelBuilder 140C, Version 5,suppats creding a Panel View
application that communicates with a Logix55xx Processor
communicdingin ControlLogix Legacy mode. A PanelView
teminal can communicate to aLogix55xx onDH+, ControlNet, and
Remote 1/0 networks. PanelView can orly communicateto a
Logix55xx pocesor when the processor is in the same chassisas the
DHRIO or CNB modues and when the Panel View terminal is
conreded to either of the above DHRIO or CNB modues.

ControlLogix Gateway

PanelBuilder 140C, Version 5, povides enhanced communicaions
for ControlLogix Gaeway bridge addressing. You can transfer
application and aam history files acioss networks using
ControlLogix bridge modues, such asthe 1756DHRIO, the
1756CNB, andthe 1756ENET.

Enhanced Font Sizes

With PanelBuilder 140@, Version 5, youcan seled tiny (6 y 14
pixels) and very tiny (4 y 10 pixels) fonts for your PanelBuil der
applications.
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Online Manuals and Enhanced Online Help

PanelB uil der 140@, Version 5,suppats online manuals. You can
install PanelBuilder 140G and PanelView manuals onto you hard
drive, or if spaceis a problem, youcan viewthe online manuals
diredly from the CD-ROM. In addition, youcan accessand view the
online manuals diredaly from your Panelbuil der 140Ge application.

Direct Object Placeme nt

PanelBuilder 140Q@g, Version 5,suppats dired placement of a
seleded oljed within a screen applicaion byentering the desired x,y
coordinates.

Snap-To Line Objects

For a grederlevel of control in screen applicaions,

PanelBuil der 140C, Version 5,can automaticdly join line ends
when they areplacead within a cettain dstance This snap-to feaure
can beturned on @ off.

Most Recently Used List

PanelB uil der 140Ce, Version 5, gves you accessto the four most
recently opened .pwc or .pvdapplicdions.



Chipter 2

Requirements for Running
PanelBuilder

Installing and Starting
PanelBuilder 1400e

This chapter covers these topics:

W

W
W
W

hardwareand softwareyou reed to run PanelBuil der
installi ng PanelBuil der

instali ng orline manuals

starting PanelBuilder for the firsttime

For installing and running PanelBuil der, the minimum system
requirements are

W

a personal computer (PC) with at leasta 486, 25MHz
microprocessor; at least 8-MB Randam AccessMemory (RAM)
for Windows 3.1; at least 16-MB RAM for Windows 95; at |east
32-MB RAM for Windows NT 4.0 and a SVGA monitor with
256 colors (recmmmended). For users working with imported .dx
files, at least 166MB RAM is required.

a permanent swap file:

w for Windows 3.1—the swap spaceplus the sum of your RAM
shoud equal at lesst 16-MB. For example, in the case of aPC
with 8&MB RAM, youwould need aswap file of at least
8-MB.

w for Windows 95—a swap file of 32-MB is required.

w for Windows NT 4.0—the swap file shoud equal the
recommended amourt in the Total Paging File Sizefor all
Drives didlog box uneér Virtual/System Propetties.

For details onconfiguring the swap fil e, seeyour applicable
Microsoft Windows User’s Guide.

hard disk with 26MB of free disk space(for installi ng)

W CD-ROM drive (or accessto a CD-ROM drive for easy

install ation and for online manuals)

w 3.5inch high-density (1.44-MB) disk drive
W standard VGA (640 by 480 display adapter with at least 256

simultaneous colors (SVGA resolution d 800 by 600 phigheris
recommended)

If youwant to resize graphic images in PanelBuil der, set your
display adapterto at least 65,536colors.
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W amouse suppated by Windows
Microsoft Windows Version 3.1 @ later, Windows 95, a
Windons NT 4.0(eatier versions of Windows NT arenct
suppated)

» Microsoft MS-DOSL Version 3.3 @ later (Version 5 o later
recommended)

Your system must be compatible with Windows. Seeyour Microsoft
WindowsUser’s Guide for spedfications.

Application File Transfer Equipment

One or more of the following peces of equipment is needed for

transferring applicdions:

W anRS232sena port for upoading a downloading applicaions
with an Allen-Bradley upoad/download ceble

w aDataHighway Plus network interface(1784KT, 1784KTX,
1770KF2), and applicable cable and conredions

w aControlNet network interface(1784KTCS, 1784KTCX,
1784KTCX15, 1776KFC), and appli cable cable and
conredions

For more information about the use of this optional equipment, see
the PanelView e Transfer Utility User Manud and the Panel View
100G, 120, and 140@ Operator Terminals User Manud.

PanelView Terminal Requirements for Running PanelBuilder
1400e Applications

You can run applications creaed in PanelBuil der 140Qe, Version 5,

onthe following PanelView teminals:

w PanelView 100G teminals, Series A and later, running Version 3
or later firmware

w PanelView 1200Series F or later color terminals that have been
enhanced with Panel View 1200Enhancement Kits (A-B Catalog
Number 2711E-U1B12C), and arerunning Version 1 a later
firmware

W PanelView 1200 Series A or later temminals, runring Version 1
or laterfirmware

W PanelView 1400 Series A or later temminals, runring Version 1
or laterfirmware
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CD-ROM Install

Note: All other PanelView 1200teminals will run orly
applications creaed in PanelBuil der 1200for DOS (A-B Catalog
Number 271END1) or PanelBuil der 1200for Windows (A-B
Catalog Number 271END1W). They will na run PanelBuilder
140GCe applications.

Note: To communicae over a ControlNet network, youmust use
a PanelView 100 or 140Ce teminal that has been upgaded to
include an ISA Card Adapter (A-B Catalog Number 2711E-NA1
or 2711E-NA2) anda 1784KTCS, 1784KTCX or
1784KTCX15cad. Or youcan use the new PanelView 14002
terminals that suppat ControlNet communicaions (A-B Catalog
Numbers 2711E-K14C7, 271E-K14C15, 271E-T14C7, and
2711E-T14C15), or the new Panel View 100@: teminals that
suppat ControlNet communicaions (A-B Catalog Numbers
2711E-K10C7, 271E-K10C15, 271E-T10C7, and
2711E-T10C15). These terminals arerealy to use with your
ControlNet network.

PanelBuilder 140Ce is offered onCD-ROM. The PanelBuil der 140G
CD contains these softwareappli cations: PanelBuil der 140,
PanelView e Transfer Utility 32,and Serid FirmwareUpgrade
Utility. The CD also contains online manuals for PanelBuil der and
PanelView. RSLinx Lite softwareis also included separaely in the
PanelBuil der 140 softwarekit; when Version 5is seleded for
install ation, RSLinx Lite software provides communicaion divers
for network fil e transfers.

You can oltain 3.5inch floppy dsks of the softwareapplicaions by
creding them from the PanelBuilder 14002 CD. For instructions on
how to creae floppy dsks of the softwarefrom the CD, referto the
file, Floppes.txt, in the root diredory of the PanelBuilder 140G CD.
Note that the PanelBuilder 140G= appli caion requires ten floppy
disks, the Transfer Utility applicaion requires threefloppy dsks, and
the Serial FirmwareUpgrade Utility applicaion requires two floppy
disks.

The following Version 5manuals areavail able onthe
PanelBuilder 14002 CD-ROM:

w PanelBuilder 140G Configuration Sdtware for Windows User
Manud (A-B Publication Number 2711E-6.14)

w PanelBuilder 140G Configuration Sdtware for Windows
Rederence Manud (A-B Publicaion Number 2711E-6.15

w PanelView e Transfer Utility User Manud (A-B Publication
Number 2711E-6.16)

w PanelView 100G, 120G, and 140@ Operator Terminals User
Manud (A-B Publication Number 2711E-6.17)
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Installing PanelBuilder
1400e Version 5 from
CD-ROM on Windows NT
or Windows 95
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The CD-ROM includes two install versions for the PanelBuil der
1400k software

w Version 3—This version dfers you PanelBuilder 140@ for use
with Windows 3.1 a later, or Windows 95. Version 3suppats
PanelView appli cétion fil e transfers over networks using
INTERCHANGE and WINtelligent LINX softwaredrivers.

W Version 5—This version dfers you PanelBuilder 140@e for use
with Windows 95 a Windows NT. Version 5suppats Panel View
application fil e transfers over networks using RSLinx software
drivers. Version 5also dffers online versions of the PanelBuil der
and PanelView manuals.

If your operaing system is Windows 3.1 a later, the CD-ROM
automaticaly installs Version 3.If your operaing system is
Windows 95, youcan install Version 3 o Version 5,athough
Version 5is recommended. If your operding system is Windows NT,
the CD-ROM automaticdly installs Version 5.

To install PanelBuilder Version 5:

1. Stat Windows NT or Windows 95.1f youareadrealy in
Windows, close al open Windows applications.

2. Placethe CD-ROM in the drive.
The CD-ROM shoud start automaticdly.

3. If theinstal does nat start automaticdly, choose Runfrom the
Start button and type d: set up. exe whered is the drive for the
CD-ROM, or seled setupexe from Windows Explorer.

4. Inthe Welcome dialog box,choose Next.

5. If youareinstlling onWindows 95, the Seled Version dalog
box appears.

Dlasorre o wilben e rrromin i i sl vl
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™ herman ez wWiliLion o IHTE R CHASLE drvs)

T o




Installing and Starting PanelBuilder 1400e 2-5

The CD-ROM includes two install versions for the PanelBuil der
1400k software

w Version 3—This version dfers you PanelBuil der 140@e for
use with Windows 3.1 a later, or Windows 95. Version 3
suppats PanelView application fil e transfers over networks
using INTERCHANGE and WINtelli gent LINX software
drivers.

w Version 5—This version dfers you PanelBuilder 140@e for
use with Windows 95 a Windows NT. Version 5suppats
Panel View appli cation fil e transfers over networks using
RSLinx softwaredrivers. Version 5also dfers orline versions
of the PanelB uil der and Panel View manuals.

If youareinstalling onWindows 95, Version 5is recommended.
If youchoase Version 3,referto “I nstalli ng PanelBuil der 140G
Version 3from CD-ROM onWindows 95 a Windowvs 3.1 @
later” in this chapter for instructions. Otherwise, continue by
seleding Version 5,and then click Next.

If youareinstalling onWindows NT, the Seled Version dalog
box daes nat appear Version 5is automaticaly seleded. Click
Next.

. When instlli ng Version 5,the PanelB uil der Install ation dalog
box appears.

PanelBuilder Installation E

WWhat would pou like ta da?

@ Install Products

m Wiew Online M anualz
i - Exit

< Back I R I Cancel

To continue with install ation, seled Install Products.

For more information on vewing ori ne manuals, see“Viewing
the Online Manuals” later in this chapter.
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. Inthe Choose Applications dialog box,chocse PanelBuil der and

the other applications you reed to install, and then click Next.

Choose Applications x|

Chooze the applications to install:

™ Transfer Utility
™ Serial Fimware Upgrade
™ Drline Manuals

< Back I Hewut » I Cancel

You can chocse more than ore applicaionto install. Chocse
Transfer Utility if you gdan to transfer appli caion fil es between a
computer and the Panel View terminal. Choacse Serial Firmware
Upgradeif you dan to upgade the firmware onthe PanelView
terminals using you computer. Choase Online Manuals to copy
the PanelB uilder and Panel View manuals to you hard drive. For
more information oninstalli ng orline manuals, see*l nstlli ng the
Online Manuals” laterin this chapter.

. Inthe Registration dalog box,type your user name, company

name, and serial number for your copy d the
PanelBuil der 140@g, and then click Next.

The serial number for your softwareis onthe Software
Registration card that was shipped with you software

. Inthe confirmation window, verify the user information you fave

entered. Seled Yesto procead, a No to edit the userinformation.
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10. InthelInstallation Options dialog box,choacse the comporents
youwant to install and then click Next.

Installation Options

— Components:
Directony: Dizk Uzage:
v PanelBuilder 1400e C:aBWPET400E Browsze I 11658 kb
¥ Help Files C:\AB\PE1400E 202 Kh
¥ Dema Files C:\aBWPET400ENDEMO 997 Kb
v Tutorial Files C:aBWFET400ENTUTORIAL 1411 Kb
¥ BockwellShared Files CARSINCMMN Browise I 342 kb
[ OLE/ODEE Spster Fles DeNWINNTYSYSTEM 5142 Kb
— Dizk Space Information
Installation drive: C:
Space available ot installation drive: 585248 Kb
Space required for inztallation: 15332 kb < Back I Newt > I Cancel

Youcan instal any or al of the following ogions:

W
W
W

PanelBuilder 140G

Help files

Demo files—These fil es demonstrate sample PanelB uil der
1400Ce applications.

Tutorial files—Thesefiles arerequired for the tutorial outlined
in this manual.

Thefollowingfiles arepart of theinstall set and canna be
deseleded:

W

OLE/ODBC System Files—These files arenecessary for
runnng PanelBuilder 140Ge.

If thisis anewinstl, you havethe option d changing the
diredory for the Rockwell Shared Files. If youmake no change,
the diredory will default to C:\RS\CMN.

If disk spaceis limited, youmay want to install only
PanelBuilder 140@. However, if you have enoughspace we
strongy recommend youalso install the Help fil es.

11. If the C:\AB\PB140(E diredory arealy exists, an Installation
dialog boxappeass, indicating the filesin the C:\AB\PB140CE
diredory will be updated. Click Yesto continue with the
install ation.
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Installing PanelBuilder
1400e Version 3 from
CD-ROM on Windows 95
or Windows 3.1 or later
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12. If the C:\RS\CMN diredory arealy exists, an Installation dalog
box appears, indicaing the filesin the C:\RS\CMN diredory
will be updated. Click Yesto continue with the install ation.

13. When the PanelBuil der 140 fil es areinstall ed, the Setup
Complete dialog boxappeass. Click Finish to continue. If you
have chosen ather applicaionsto install, the next seleded
application automaticaly beginsto install.

For more information oninstalling and runnng aher
applications, seeChapter 3, Installing and $arting the Panel View
e Transfer Utility, and Chapter 4, Installing and $arting the
PandView Serial Firmware Upgrade Utilit y.

14. Afterall the applicdions have completed installing, youwill be
prompted to rebod your computer. You may reboad immediately
or later, but youmust reboa before you can run PanelBuilder
140G or other appli caions succesully.

If youchoaoseto install the Transfer Utility and youwant to
upload o download PanelView fil es over the PLC networks, you
aso nead to instal RSLinx Lite software 2.0 a later, which is
provided separaely in the PanelB uilder 140Qe kit. Seethe
documentation provided with RSLinx Lite for install ation
procedures.

To install PanelBuilder Version 3:

1. Start Windows 95, @ 3.1 a later. If youarearealy in Windows,
close al open Windows applications.

2. Placethe CD-ROM inthe drive.
The CD-ROM shoud start automaticdly.

3. If theinstal does na start automaticdly and youarerunning on
Windows 95, choase Run from the Start button and type
d: set up. exe whered is drive for the CD-ROM, or seled
setup.exe from Windows Explorer.

If youarerunning onWindows 3.1 a later, choose Run from the
File menu. In the Runwindows, type:

d: setup

whered is the drive containing the PanelBuilder 140G CD-ROM,
and pressEnter.
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4,
5.

Current Directory: C:A\WIHAPPS

LCommand Line:

|d:selup | Cancel

] Run Minimized

In the Welcome dialog box,choase Next.

If youareinstalling onWindows 95,the Seled Version dalog
box appears. Choose Version 3,and then click Next.

If youareinstalling onWindows 3.1 @ later, the Seled Version
dialog box des nat appear Version 3is seleded automaticdly.

In the Choose Applications dialog box,chocse PanelBuilder and
the other applications youwant to install, and then click Next.

You can chocse more than ore applicationto install. Chocse File
Transfer Utility if you gdan to transfer application fil es between a
computer and the PanelView teminal. Choase Sera Firmware
Upgradeif you dan to upgade the firmwareon you PanelView
terminals using you computer.

Coiei P cprDRCasy i I npiall
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Close al open Windows applications. If you have dore so, click
Next.

In the Registration Information window, enter your user name,
company name, and serial number. After youenter the required
information, click Next.

The serial number for your softwareis onthe Software
Registration card that was shipped with you software
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9.

10.

In the confirmation window, verify the userinformation you lave
entered. Seled Yesto procead, a No to edit the userinformation.

The Install ation Options dialog boxlists the program comporents
you areinstalling and the amount of hard disk spacerequired for
ead.

Choase the comporents youwant to install and click Continue.

Installation Options

rComponents:
Directon: Disk Uzage:
| C:\4B4PE1400E 16192 Kb
¥ Help Files C:'AB4PE1400E 800 Kb
X Demo Files C:\ABWPE1400ENDEMO T84 Kb
[ Tutorial Files C:\ABWPE1400ENTUTORIAL 1924 Kb
% Rockwell Shared Files 192 Kb
[¥ OLE/ODEC System Files AN ITT18SYSTEM E440 Kb
Dizk Space Informatiors
Installation drive: :
Space available on inztallation drive: E02880 Kb
Space required after installation: 31732 Kb I Continue I | Esit I

You can instal any or al of the following ogions:

W PanelBuilder 140G

w Helpfiles

W Demo files—These fil es demonstrate sample
PanelB uil der 140Ce appli cations.

w Tutorial files—These files arerequired for the tutorial outlined
in this manual.

The followingfiles arepart of the install set and canna be
deseleded:

W OLE/ODBC System Files—Thesefiles arenecessary for
runnng PanelBuilder 140Ge.

If this is anewinstl, you have the option d changingthe
diredory for the Rockwell Shared Files. Otherwise, it will default
to C:\RS\CMN.

If disk spaceis limited, youmay want to install only PanelBuil der
1400 However, if you have enoughspace we strondy
recommend youalso install the Help fil es.

11. If the C:\AB\PB140CE diredory alrealy exists, an Installation

dialog boxappears, indicaing the filesin the C:\AB\PB140(E
diredory will be updated. Click Yesto continue with the
install ation.
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Installing PanelBuilder
1400e Version 5 from
Floppy Disks on Windows
NT or Windows 95

12.

13.

14.

If the C:\RS\CMN diredory arealy exists, an Installation dalog
box appears, indicaing the filesin the C:\RS\CMN diredory
will be updeted. Click Yesto continue with the install ation.

When the PanelBuilder 140@e fil es areinstall ed, a PanelBuil der
140 Install ation dalog boxappeass to confirm completion.
Click Finish to continue. If you have chosen ather applicationsto
install, the next seleded application automaticdly begins to
install.

For more information oninstalling and running aher
applications, seeChapter 3, Installing and $arting the PanelView
e Transfer Utility, and Chapter 4, Installing and &artingthe
PanelView Serial Firmware Upgrade Utility.

Afterall the applicaions have completed installi ng, the Setup
Complete dialog boxappeass. Youwill be prompted to reboat
Windows or your computer. You may rebod immediately or later,
but you must reboa before you can run PanelBuil der 140G or
other applications succes<ully.

If youchoaseto install the PanelView 1200140Ce Transfer
Utility and youwant to udoad or download fil es overthe PLC
networks, youaso need to install INTERCHANGE or
WINTtelligent LINX software If you do nd have this software
contad Allen-Bradley Technicd Suppat for assisance

To oltain 3.5inch floppy dsks of the softwareappli caions, crede
them from the PanelBuilder 140@e CD. For instructions on hav to
crede floppy dsks of the softwarefrom the CD, referto thefil e,
Floppes.txt, in theroot diredory of the PanelB uil der 140G CD.
PanelBuilder 140Ce requires ten floppy dsks, the Transfer Utility 32
requires threefloppy dsks, andthe Serid FirmwareUpgrade Utility
requires two floppy dsks.

To install PanelBuilder Version 5:

1. Start Windowvs NT or Windows 95. If youarealrealy in

Windows, close all open Windows applications.
Insert the floppy dsk in the drive.

Choase Run from the Start button andtype a: set up. exe wherea
is the drive for the floppy dsk, or seled a:\setup.exe from
Windows Explorer.

Theinstllation kegins.

Close al open Windows applications. If you have dore so,
choose Next.
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5.

In the User Information dalog box,type your user name,
company name, and the serial number for you copy d
PanelBuil der 140@e, and then click Next.

The serial numberfor your softwareis onthe Software
Registration card that was shipped with you software

The Installation Options dialog boxlists the program comporents
you areinstali ng and the amourt of hard disk spacerequired for
ead.

Choase the comporents youwant to install and click Next.

Installation Options

— Components:
Directony: Dizk Uzage:
CAABPET400E | Browse | 1igsake
¥ Help Files C:\AB\PE1400E 202 Kh
¥ Dema Files C:\aBWPET400ENDEMO 997 Kb
v Tutorial Files C:aBWPET400ESTUTORIAL 1411 Kb
¥ BockwellShared Files CARSINCMMN Browise I 342 kb
[ OLE/ODEE Spster Fles DeNWINNTYSYSTEM 5142 Kb
— Dizk Space Information
Installation drive: C:
Space available ot installation drive: 585248 Kb
Space required for inztallation: 15332 kb < Back I Newt > I Cancel

Youcan instl any or al of the following ogions:

w PanelBuilder 14002

w Helpfiles

w Demo files—These files demonstrate sample PanelBuil der
1400Ce applications.

w Tutorial files—Thesefiles arerequired for the tutorial outlined
in this manual.

The followingfiles arepart of the install set and cannat be
deseleded:

W OLE/ODBC System Files—Thesefiles arenecessary for
running PanelBuilder 140G
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10.

If thisis anewinstll, you havethe option d changing the
diredory for the Rockwell Shared Files. Otherwise, it will default
to C:\RS\CMN.

If disk spaceis limited, youmay want to instal only PanelBuil der
140G However, if you have enoughspace we strondy
recommend youalso install the Help files.

If the C:\AB\PB140(E diredory drealy exists an Install ation
dialog boxappears, indicating the filesin the C:\AB\PB140CE
diredory will be updated. Click Yesto continue with the
install ation.

If the C:\RS\CMN diredory arealy exists an Instalation daog
box appears, indicaing the filesin the C:\RS\CMN diredory
will be updeted. Click Yesto continue with the install ation.

When the PanelBuilder 140G files areinstall ed, an Install ation
dialog boxappears to confirm completion. Click Finish to
continue.

For more information oninstalling and running aher
applicaions, seeChapter 3, Installing and &arting the Panel View
e Transfer Utility, and Chapter 4, Installing and &arting the
PanelView Serial Fir mware Upgrade Utility.

Aftertheinstallationis complete, youwill be prompted to reboc
your computer. You can reboa immediately or later, but you must
reboa before you can run PanelBuilder 140@g, or other
applications succesgully.

To transfer appli cation fil es between a computer and the
PanelView terminal, youmustinstal the PanelView e Transfer
Utility 32.For instructions on hav to install this utility, see
Chapter 3, Installing and $arting the PanelView e Transfer
Utility. If youinstall the Transfer Utility and youwant to udoad
or download PanelViewfil es over the PLC networks, youalso
need to install RSLinx Lite software 2.0 @ later, which is
provided separéely in the PanelBuil der 140 kit. Seethe
RSLinx Lite documentation for install ation procedures.

To upgade the firmwareon you PanelViewteminal using you
computer, youmustinstal the Serial Firmware Upgrade Utility.
For instructions on hav to install this utility, see Chapter 4,
Installing and &rting the PanelView Serial Firmware Upgrade
Utility.
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Installing PanelBuilder
Version 3 from Floppy
Disks on Windows 95 or
Windows 3.1 or later
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To oltain 3.5inch floppy dsks of the softwareapplications, creae
them from the PanelBuilder 140G CD. For instructions on hav to
crede floppy dsks of the softwarefrom the CD, referto thefile,
Floppes.xt, in theroaot diredory of the PanelBuilder 140G CD.
PanelB uil der 140Ce requires nine floppy dsks, the Transfer Utility
32requirestwo floppy dsks, and the Seria FirmwareUpgrade
Utility requires two floppy dsks.

To install PanelBuilder Version 3:

1. Start Windows 95, a 3.1 a later. If youarealrealy in Windows,
close al open Windows applications.

2. Insert the floppy dsk in the drive.

3. If youarerunnng onWindows 95, choacse Run from the Start
button and type a: set up. exe wherea is the drive for the floppy
disk, or seled a:\setup.exe from Windows Explorer.

If youarerunnng onWindows 3.1 a later, choose Run from the
File menu. In the Runwindows, type:

a:setup Or b:setup

wherea or b is the drive containing the PanelB uil der disk, and
pressEnter.

= Run

Command Line:

| ﬁ:setup| | Cancel

D Run Minimized Browse._..

4. Closeall open Windows applicaions. If you have dore so, click
Next.

5. Intheregistration window, enter registration information abou
your copy d PanelBuilder, and then click Next to continue.

The serial numberfor your softwareis onthe Software
Registration card that was shipped with you software

6. TheInstallation Options dialog boxlists the program comporents
you areinstali ng and the amourt of hard disk spacerequired for
ead.

Choose the componrents youwant to install and click Continue.
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rComponents:
Directony: Dizk Usage:
| C:a84PB1400E 161592 Kb
X Help Files C:AABNPET400E 800 Kb
[ Demo Files C:\AB%PE1400ENDEMOD 184 Kb
% Tutorial Files C:AABNPET400ENTUTORIAL 1984 Kb
[% | Rockwell Shared Files 1192 Kb
[ OLE/ODELC System Files CAWINITIASYSTEM 5440 Kb
rDizk Space Informatiors
Ingtallation drive: C:
Space available on installation drive: B02880 Kb
Space required after installation: 3752 Kb e I | Exit I

You caninstal any or al of the following ogions:

w PanelBuilder 14062

W Helpfiles

w Demo files—These fil es demonstrate sample PanelB uil der
140Ce applications.

w Tutorial files—Thesefiles arerequired for the tutorial outlined
in this manual.

The following files arepart of theinstall set and canna be
deseleded:

W OLE/ODBC System Files—Thesefiles arenecessary for
running PanelB uilder 140Ge.

If disk spaceis limited, youmay want to instal only PanelBuil der
140G However, if you have enoughspace we strondy
recommend youalso install the Help files.

7. Change the destination dive and dredory, if desired. By default,
thisis C:\AB\PB140CE. To change the destination dive or
diredory, type the new drive and/or diredory in the Diredory
field.

If the Rockwell shared files have been installed previously, you
canna change their locdion. If they have nat yet been install ed,
you can change the default diredory.

8. To procea with instalation, chocse Cortinue. To cancd the
install ation, click Exit.

9. If the C:\RS\CMN diredory arealy exists, an Installation dalog
box appears, indicaing the filesin the C:\RS\CMN diredory
will be updeted. Click Yesto begin theinstall ation.
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Installing the Online
Manuals
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10. Follow the setup instructions as they appearonthe screen.

To complete the setup, enter any required information and insert
disks when prompted. Continue this procedure urtil you have
installed all disks.

. Aftertheinstallationis complete, youwill be prompted to reboa

your computer. You can reboa immediately or later, but youmust
reboa before you can run PanelBuil der 140@ succesgully.

To transfer appli cation fil es between a computer and the

Panel View terminal, youmustinstall the PanelView 12001400
Transfer Utility. For instructions on hav to install this utility, see
Chapter 3, Installing and $arting the PanelView e Transfer
Utility. If youinstal the Transfer Utility and youwant to udoad
or download PanelView fil es over the PL C networks, youalso
need to install INTERCHANGE or WINtelli gent LINX software
If you do no have this software contad Allen-Bradley Tedhnicd
Suppat.

If youwant to upgade the firmwareon you PanelView terminal
using you computer, youmustinstal the Seria Firmware
Upgrade Utility. For instructions on haw to install this utility, see
Chapter 4, Installing and $arting the PanelView Serial Firmware
Upgrade Utility.

You can install the PanelBuil der and Panel View manuals diredly
from the CD-ROM. Online manuals areavail able only if you wse
Version 5.You canna accessthe online manuals if you wse
Version 3.

Note: Toinstall the online manuals youwill require approximately
12-MB of hard drive space(6-MB for the manuals and 6MB for
Adobe Acrobat).

To install online manuals onto your hard drive:

1. Start Windons NT or Windows 95.1f youarealrealy in

Windows, close al open Windows applications.

2. Placethe CD-ROM inthe drive.

The CD-ROM shoud start automaticdly.
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10.

12.
13.

If the install does nat start automaticdly, chocse Run from the
Start button and type d: set up. exe whered is the drive for the
CD-ROM, or seled setupexe from Windows Explorer.

In the Welcome dialog box,click Next.

If youareinstalling onWindows 95,the Seled Version dalog
box appears. Seled Version 5,and then click Next.

If youareinstalling onWindows NT, the Seled Version dalog
box daes nat appear Version 5is automaticaly seleded.

When installi ng Version 5,the PanelB uilder Install ation dalog
box appears.

To continue with install ation, choose Instal Products.
In the Choaose Applications dialog box,chocse Online Manuals.

If you have nat previously install ed PanelBuilder 140@ Version
5, the Registration dalog boxappeas. Type your user name,
company name, and serial number, and then click Next.

The Adobke Acrobat Setup dalog boxappeass. To install Adoke
Acrobat on you hard drive, click Next.

Note: Follow the online instructions for the Adobe Acrobat
install urtil you get to the Online Manuals Destination dalog
box.

When the Online Manuals Destination dalog boxappeass, you
can change the destination dive and dredory. The default is
C:\AB\PB140(EE\MANUAL S. To change the destination drive or
diredory, click the Browse button.

Choase Next to install the PanelBuil der and Panel View manuals.
You mustinstal all the manuals.

The Selea Program Folder dialog boxappeass. The PanelBuilder
140G program folder will be updated and youcan change the
program folder, if desired. Click Next to continue.

The online manuals begin loading.
The Setup Complete dialog boxappeass. Click Finish to continue.

Aftertheinstall ationis complete, youwill be prompted to rebod
your computer. You may rebod immediately or later, but you
must reboa before you can run PanelBuil der 140Ce or other
applications succesdully.
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You can view the PanelB uil der and Panel View manuals diredly from
the CD-ROM. Online manuals areavail able only if you wsed the
Version 5CD-ROM.

To view online manuals from your hard drive:
1. Choose the Start button.

2. Choose Programs, and then choaose the PanelBuil der 140G
folder.

3. Choose View Online manuals.

To view the online manuals from the CD-RO  M:
1. Start Windowvs NT or Windows 95.
2. Placethe CD-ROM inthe drive.

The CD-ROM shoud start automaticdly.

3. If theinstal does nat start automaticdly, choose Runfrom the
Start button and type d: set up. exe whered is the drive for the
CD-ROM, or seled setupexe from Windows Explorer.

4. Inthe Welcome dialog box,click Next.

5. If youareviewing onWindows 95, the Seled Version dalog box
appeass. Seled Version 5,and then click Next.

If youareviewing onWindows NT, the Seled Version dalog box
does nat appear Version 5is automaticdly seleded.

6. The PanelBuilder Installation dalog boxappeas. Choose View
Online Manuals to continue.

7. The Adobke Acrobat viewerappeass. Click the manual youwant
to view.

The first page of the online manual appeass.

8. When youarefinished viewing the online manuals, click the
close button to exit the Acrobat viewer

9. The PanelBuilder Instalation dalog boxappeass. Click Exit to
finish with the online manuals.
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To start PanelBuilder from Windows 3.1 or later:

Double-dick the PanelBuilder 140Ge icon.

The PanelB uil der 140G Window appeals on you screen. You are
ready to begin workingin PanelBuilder.

If you have problemsrunning PanelBuilder 140@, ched the
Readme.txt file for patential system coniflicts, and contact
Allen-Bradley Technicd Suppat. For Technicd Suppat
information, seethe Prefacein this manual.
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Chipter 3

General _Installation
Information

Installing and Starting the
PanelView e Transfer Utility

This chapter covers these topics:
w installing PanelView e Transfer Utility
w starting PanelView e Transfer Utility for the firsttime

You may install the PanelView e Transfer Utilit y softwareusing the
CD-ROM provided in the PanelBuil der 140@e softwarekit (A-B
Catalog Number 2711E-ND1). You can aso instal the PanelView e
Transfer Utility softwarefrom the floppy dsks provided in the
Panel View software padage (A-B Catalog Number 2711E-ND7).

You may also oltain floppy dsks of the PanelView e Transfer Utility
software by creding them from the PanelBuil der 140G CD. For
instructions on hav to crede floppy dsks of the softwarefrom the
PanelBuilder 140G CD, referto thefil g, titled Floppges.txt, in the
root diredory of the PanelBuilder 140G CD.

The CD-ROM includes two install versions of the PanelView e
Transfer Utility software

w Version 3—This version dfers youthe PanelView 12001400
Transfer Utility (FTU) onan operéing system that uses Windows
3.1 a later, or Windows 95. Version 3suppats INTERCHANGE
and WINtelligent LINX driversfor Panel View 100G, 1200,
120Qe, and 140@ network fil e transfers. For more information on
this FTU and its functionality, seethe PanelView 12001400
Transfer Utility User Manual (A-B Publi cation Number
2711E-6.98).

w Version 5—This version dfers youthe PanelView e Transfer
Utility 32 (FTU32) softwareonan operaing system that uses
Windows 95 a Windows NT. Version 5suppats RSLinx drivers
for PanelView 100CG, 120@, and 140@ network fil e transfers.

If your operéing system is Windows 3.1 @ later, the CD-ROM will
automaticdly install Version 3.If your operding systemis
Windows 95, you lave achaice of installing Version 3 o Version 5.
If your operaing system is Windows NT, the CD-ROM will
automaticdly install Version 5.
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Installing FTU32 Version 5
from CD-ROM on Windows
NT or Windows 95
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PanelView e Transfer Utility 32 (FTU32) Version 5is provided on
the PanelBuilder 14002 CD-ROM. The softwareinstall ation program
credesadiredory on you hard drive for the FTU32 and copies all
necesary filesto it. By default, the drive and dredory is
C:\AB\PB140(E\FTU32. You can change this default.

To install FTU32:

1

Start Windows 95 a Windows NT. If youarealrealy in
Windows, close all open Windows appli céionrs.

Placethe CD-ROM in the drive.
The CD-ROM beginsto run automaticdly.

If theinstall does nat start automaticdly, chocse Run from the
Start button and type d: set up. exe whered is the drive for the
CD-ROM, or seled setupexe from Windows Explorer.

In the Welcome dialog box,click Next.

If youareinstlling onWindows 95,the Seled Version dalog
box appears.
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The CD-ROM includes two install versions for the Transfer
Utility software

w Version 3—This version dfers youthe Transfer Utility onan
operding system that uses 3.1 @ later, or Windows 95.
Version 3suppats PanelView appli caion fil e transfers over
networks using INTERCHANGE and WINtelli gent LINX
softwaredrivers.

w Version 5—This version dfers youthe Transfer Utility onan
operaing system that uses Windows 95 a Windows NT.
Version 5suppats PanelView appli cation fil e transfers over
networks using RSLinx softwaredrivers.
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If youareinstalling onWindows 95, Version 5is recommended.
If youchoase Version 3,referto “I nstalling FTU from CD-ROM
onWindows 95 a Windows 3.1 a later” in the PanelView
1200140 Transfer Utility User Manual (A-B Publication
Number 2711E-6.8). Otherwise, to continue seled Version 5,and
then click Next.

If youareinstalling onWindows NT, the Seled Version dalog
box daes nat appear Version 5is automaticaly seleded.

. Inthe PanelB uil der Install ation dalog box,chocse Instll
Products to continue with install ation.

1||-:ﬂ|.|-_-.| cansd |

For more information on vewing onine manuals, see Chapter 2,
Installing and &arting PanelBuil der 140Ce.

. Inthe Choase Applications dialog box,choacse Transfer Utility as
the applicaion youwant to install. You can chocse more than ore
applicaionto install. Click Next.
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8.

10.

12.

13.

14.

15.

In the registration window, enter your user name, company name,
and serial number. You can oltain registration information from
the softwareregistration card that is in you PanelBuilder 140G
padkage (A-B Catalog Number 2711E-ND1) or PanelViewe
Transfer Utility padkage (A-B Catalog Number 2711E-ND7).
Click Next.

In the confirmation window, verify the userinformation you fave
entered. Seled Yesto proceel o No to edit the user information.

The Welcome diadlog boxfor the Transfer Utility recommends
that you close all open Windows applicaions. If you have dore
that, click Next.

If you have chosen ather applicationsto install, the first seleded
application automaticaly beginsto install.

Choaose the drive and dredory in which the FTU32 will be
install ed. By default, this is C:\AB\PB140(E\FTU32. To change
the destination dive or diredory, type the new drive and/or
diredory in the Program Filesfield. Or, click onthe Browse
buttonto seled an installation dredory. Then click Next.

Choase the program folder (program group) in which youwant to
install the FTU32 sicons, which includes a Readme fileicon, the
Transfer Utility icon, and an Uninstall icon. By default, the icons
areinstall ed in the PanelBuilder 140G: program folder. Then
click Next.

Choase whether the install ation uility will modify the
AUTOEXEC.BAT file.

If youareinstalling onWindows 95, the entry
C:\ Progr a~1\ Rockwe~1\ RDM %Pat h%
is required in the PATH variable for the FTU32to work corredly.

If youareinstalling onWindows NT, the entry

C.\ Program Fi | es\ Rockwel | Sof t war e\ RDM

is required in the PATH variable in the Environment tab o the
System Propetties dialog.

Click Next to approve and continue.

The setup uility shows asummary of the choices youmade in the
precaling dalog boyes. To make any changes, click the Back
button. Otherwise, click Next to begin instali ng the fil es.

Afterall the applicaions have been installed, youwill be
prompted to rebod your computer. You may rebod immediately
or later, but youmust reboat before you can runthe Transfer
Utility or other appli cations succes<ully.
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Installing FTU Version 3
from CD-ROM on Windows
95 or Windows 3.1 or later

After youfinish installi ng the Transfer Utility and youwant to
upload o download Panel Viewfil es over the PLC networks, you
also reed toinstal RSLinx Lite software 2.0 o later, which is
provided separaely in the PanelBuilder 140@e kit. Seethe
RSLinx user documentation provided for install ation procedures.

Do na cancd theinstallation whileit is in progress If youwant to
undothe installation, let the install ation finish, then use the Uninstall
PanelView e Transfer Utility 32iconto remove al the install ed fil es
and to updhte the registration.

PanelView 12001400 Transfer Utility (FTU) Version 3is provided
onthe PanelBuilder 1400 CD-ROM. The softwareinstall ation
program credes a diredory on you hard drive for the FTU and
copiesal necessay filesto it. By default, the drive and dredory is
C:\AB\PB140CE\FTU. You can change this default.

For more information onthis FTU and its functionality, seethe
PandView 12001400 Transfer Utility User Manud (A-B
Publication Number 2711E-6.8).

To install FTU:

1. Start Windows 95 a Windows 3.1 a later. If youarealrealy in
Windows, close al open Windows applications.

2. Insert the CD-ROM in the drive.
The CD-ROM beginsto run automaticdly.

3. If theinstal does na start automaticdly and youarerunnng on
Windows 95, chocse Run from the Start button and type
d: set up. exe whered is the drive for the CD-ROM, o seled
setup exe from Windows Explorer.

If youarerunning onWindows 3.1 a later, choose Run from the
File menu. In the Runwindows, type:

d: setup

whered is the drive containing the File Transfer Utility
CD-ROM, and pressEnter.

Current Directory: C:AWINAPPS

Command Line:

|d:setup | Cancel

] Run Minimized
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4,
5.

10.

In the Welcome dialog box,click Next.

If youareinstalling onWindows 95,the Seled Version dalog
box appeais. Choose Version 3,and then click Next.

If youareinstling onWindows 3.1 o later, the Seled Version
dialog box des nat appear Version 3is automaticadly seleded.

In the Choose Applications dialog box,chocse File Transfer
Utility asthe application youwant to install. You can chocse
more than ore applicaionto install. Then click Next.

oot Pl e 0w vi (T il

AT i

= i Trora e Liiny
T Com Frrrees Lty

« Back e b |

The Welcome dialog boxfor the File Transfer Utility
recommends that you close all open Windows applications. If you
have dore that, click Next.

In the registration window, enter the required information. You
can oltain registration information from the softwareregistration
card that is in you PanelBuilder 140@ package. Click Next.

Choase the drive and dredory in which the FTU will be

install ed. By default, thisis C:\AB\PB140(E\FTU. To change the
destination drive or diredory, type the new drive and/or diredory
in the Program Filesfield. Then click Next.

Choose the program folder (program group) in which youwant to
install the FTU’sicons, which includes a Readme fileicon, the
Transfer Utility icon, and an Uninstal icon. By default, the icons
areinstall ed in the PanelBuil der 140@ program folder. Then
click Next.

Choase whether the install ation uility will modify the
AUTOEXEC.BAT file. The entry

C:\RSI\ CWN

is required in the PATH variable for the FTU to work corredly.

Then click Next.
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Installing FTU32 Version 5
from Floppy Disks on
Windows NT or

Windows 95

12. The setup uility shows a summary of the choices you made in the
precaling dalog boyes. To make any changes, click the Badk
button. Otherwise, click Next to begin installi ng the fil es.

13. Afterall the applications have been installed, youwill be
prompted to reboa your computer. You may rebod immediately
or later, but youmust reboa before you can runthe Transfer
Utility or other applications succes<ully.

After youfinish installi ng the Transfer Utility and youwant to
upload o download Panel Viewfil es over the PLC networks, you
aso nead toinstal INTERCHANGE or WINtelli gent LINX
software If you do no have this software contad Allen-Bradley
Tedhnicd Suppat for assisance

Do na cancd theinstallation whileit is in progress If youwant to
undothe installation, let the install ation finish, then use the Uninstall
Transfer Utility icon to remove al the install ed files and to update
the registration.

PanelView e Transfer Utility 32 (FTU32) Version 5is provided in
the Transfer Utility kit (A-B Catalog Number 2711E-ND7) onthree
disks. Before instali ng the software make a badkup copy d the
disks. Store the original disksin asafe place andinstll the FTU32
from the copy.

FTU32is also provided onthe PanelBuilder 140G CD. Youcan
obtain 3.5inch floppy dsks by creding them from the CD. For
instructions on haw to crede floppy dsks of the softwarefrom the
CD, referto thefil g, titled Floppes.txt, in the roct diredory of the
PanelBuilder 140G CD.

To install FTU32:

1. Start Windowvs NT or Windows 95. If youarealrealy in
Windows, close all open Windows applications.

2. Insert the floppy dsk in the drive.

3. Choose Runfrom the Start button andtype a: set up. exe wherea
is the drive for the floppy dsk, or seled a:\setup.exe from
Windows Explorer.

4. The Welcome dialog boxfor the Transfer Utility recommends
that youclose al open Windows applicaions. If you have dore
that, click Next.

5. Intheregistration window, enter registration information about
your copy d the FTU32. You can oltain registration information
from the softwareregistration cad that is in you
PanelBuilder 140Ce or Transfer Utility padkage.
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10.

Choose the drive and dredory in which the FTU32 will be
installed. By default, this is C:\AB\PB140(E\FTU32. To change
the destination dive or diredory, type the new drive and/or
diredory in the Program Files field. Then click Next.

Choase the program folder (program group) in which youwant to
install the FTU32 sicons, which includes a Readme fileicon, the
Transfer Utility icon, and an Uninstall icon. By default, the icons
areinstalled in the PanelBuilder 140@: program folder. Then
click Next.

Choase whether the install ation uility will modify the
AUTOEXEC.BAT file.

If youareinstalling onWindows 95, the entry
C:\ Progr a~1\ Rockwe~1\ RDM %Pat h%
is required in the PATH variable for the FTU32to work corredly.

If youareinstalling onWindows NT, the entry

C.\ Program Fi | es\ Rockwel | Sof t war e\ RDM

is required in the PATH variable in the Environment tab o the
System Propetties dialog.

Click Next to approve and continue.

The setup uility shows asummary of the choices youmade in the
precaling dalog boyes. To make any changes, click the Back
button. Otherwise, click Next to begin instali ng the fil es.

Afterall the applicaions have been installed, youwill be
prompted to rebod your computer. You may rebod immediately
or later, bu youmustreboat before you can runthe Transfer
Utility or other appli cations succes<ully.

After youfinish installi ng the Transfer Utility and youwant to
upload o download PanelViewfil es over the PLC networks, you
also read toinstal RSLinx Lite software 2.0 o later, which is
provided separaely in the PanelBuilder 140@ kit. Seethe
RSLinx user documentation provided for install ation procedures.

Do na cancd theinstall ation whileit is in progress If youwant to
undothe installation, let the install ation finish, then use the Uninstall
PanelView e Transfer Utility 32iconto remove al the install ed files
and to updhte the registration.
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Installing FTU Version 3
from Floppy Disks on
Windows 95 or Windows
3.1 or later

PanelView 12001400 Transfer Utility (FTU) Version 3is provided
in the Panel View 12001400 Transfer Utility kit (A-B Catalog
Number 2711E-ND7) ontwo dsks. Before installi ng the software
make a badkup copy d the disks. Store the original disksin a safe
place andinstall the FTU from the copy.

FTU is also provided onthe PanelBuilder 140@: CD. You can oltain
3.5-inch floppy dsks by creding them from the CD. For instructions
on haw to creae floppy dsks of the softwarefrom the CD, referto
thefile, titled Floppes.txt, in theroat diredory of the

PanelBuilder 140G CD.

For more information onthis FTU and its functionality, seethe
PanelView 12001400Ce Transfer Utility User Manud (A-B
Publication Number 2711E-6.8).

To install FTU:

1. Start Windows 95 a Windows 3.1 a later. If youarearealy in
Windows, close al open Windows applications.

2. Insert the floppy dsk in the drive.

3. If youarerunnng onWindows 95, chocse Run from the Start
button andtype a: set up. exe wherea is the drive for the floppy
disk, or seled a’\setup.exe from Windows Explorer.

If youarerunning onWindows 3.1 a later, choose Runfrom the
File menu. In the Runwindow, type:

a:setup Or b:setup

wherea or b is the drive containing the Panel View 12001400
Transfer Utility disk, and reSSenTer.

=5 Run

Command Line:

| asetup| | Cancel

D Run Minimized Browse...

410
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4.

10.

A window appeass, recommending youclose al open Windows
applications. If youfollowed step 1, click Next; otherwise close
al open Windows appli cations now. Then click Next. The File
Transfer Utility Install ation Program runs automaticdly.

In the registration window, enter registration information about
your copy d the FTU. You can oltain registration information
from the softwareregistration cad that is in you PanelBuilder
140Qe or PanelView 1200140Ce Transfer Utility padkage.

Choase the drive and dredory in which the FTU will be
installed. By default, this is C:\AB\PB140(E\FTU. To change the
destination drive or diredory, type the new drive and/or diredory
in the Program Filesfield. Then click Next.

Choase the program folder (program group) in which youwant to
install the FTU’sicons, which includes a Readme fileicon, the
Transfer Utility icon, and an Uninstall icon. By default, the icons
areinstaled in the PanelBuilder 140G program folder. Then
click Next.

Choase whether the install ation uility will modify the

AUTOEXEC.BAT file. The entry
C:\RSI\ CW

is required in the PATH variable for the FTU to work corredly.
Then click Next.

The setup uility shows asummary of the choices youmadein the
precaling dalog boxes. To make any changes, click the Back
button. Otherwise, click Next to begin instali ng the fil es.

Afterall the applicaions have been installed, youwill be
prompted to rebod your computer. You may rebod immediately
or later, but youmust reboat before you can runthe Transfer
Utility or other appli cations succes<ully.

After youfinish installi ng the Transfer Utility and youwant to
upload o download PanelView fil es over the PLC networks, you
aso rnead toinstal INTERCHANGE or WINtelli gent LINX
software If you do no have this software contad Allen-Bradley
Tedhnicd Suppat for assisance

Do na cancd theinstallation whileit is in progress If youwant to
undothe installation, let the install ation finish, then use the Uninstall
Transfer Utility icon to remove al the install ed files and to updite
the registration.
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Starting the PanelView e Panel View e Transfer Utility 32 Version 5(FTU32) runs on
Transfer Utility 32 WindowsNT or Windows 95.
Version 5 (FTU32) This sedion describes how to start the program from Windows NT

and Windows 95. Screa ill ustrations arefrom the Windows NT
environment. Functionality of the transfer utility is the same for
Windows NT and Windows 95.

To start FTU32 from Windows NT or Windows 95:
1. Click the Start button from the taskbar.

2. Choose Programs, and choose PanelB uil der 140Ce or the folder
you spedfied when youinstall ed the program.

3. Choose PanelView e Transfer Utility 32. The following dalog
boxis displayed.

R S

If you have problemsrunning the Transfer Utility and you lave
had previous versions of the Transfer Utility on you computer,
we recmmend youseled “Uninstall PanelView e Transfer
Utility 32’ in the PanelBuilder 140@e folder. The “U ninstall
PanelView e Transfer Utility 32' program deletes any o the
shared fil es and windows system fil e confli cts that may exist
from eatierinstallations. Youwill then haveto reinstall the
Transfer Utility softwareagain. If problemsstill exist, contad
Allen-Bradley Technicd Suppat. For Technicd Suppat
information, seethe Prefacein this manual.
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Exiting the PanelView e
Transfer Utility 32

Starting the PanelView
1200/1400e Transfer Utility
Version 3 (FTU)
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When you lave finished transferring appli cations, exit the Transfer
Utility.

To exit the Transfer Utility:

Choocse Close from the File menu, gressALT +F4, or click onthe
Close button.

PanelView 12001400Ce Transfer Utility Version 3(FTU) runson
Windows 3.1 a later, or Windows 95.

This sedion describes how to start the program from Windows 3.1 o
later, and Windows 95. Screen ill ustrations arefrom the Windows
3.1 environment. Functionality of the transfer tility is the same for
Windows 3.1 a later, and Windows 95.

To start FTU from Windows 3.1 or later:

1. Doube-dick the PanelBuilder 140G program group (or the
program group youseleded when youinstal ed the software)

2. Doule-dick the PanelView 12001400Ce Transfer Utility icon.

If you have problemsrunnng the File Transfer Utility, ched the
Readme.txt file for patential system coniflicts, and contacdt
Allen-Bradley Tedhnicd Suppat. For Technicd Suppat
information, seethe Prefacein this manual.

To start FTU from Windows 95:
1. Click the Start button from the taskbar.

2. Choose Programs and choase PanelBuil der 140@ or the folder
you spedfied when youinstall ed the program.

3. Choose PanelView 1200140Q Transfer Utility. The following
dialog boxis displayed.

= PanelView 1200 1400e Transfer Utility n -
Transfer Help
Fieady [12:30:02
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If you have problemsrunning the File Transfer Utility and you
have had previous versions of the File Transfer Utility on you
computer, we recommend youseled “Uninstal Transfer Utility”
in the PanelBuilder 140Ce folder. The “Uninstall Transfer Utility”
program deletes any of the shared fil es and windows system file
conflicts that may exist from eatierinstall ations. Youwill then
have to reinstall the File Transfer Utility softwareagain. If
problemsstill exist, contad Allen-Bradley Technicd Suppat. For
Technicd Suppat information, seethe Prefacein this manual.

For more information seethe Panel View 12001400e Transfer
Utility, seethe PanelView 12001400 Transfer Utility User Manud
(A-B Publication Number 2711E-6.8).

For information on hev to start and exit the PanelView 1200
Transfer Utility, seethe PanelView 1200Transfer Utility User
Manud (A-B Publication Number 2711811).
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Installing SFU32 Version 5
from CD-ROM on Windows
NT or Windows 95

Installing and Starting the
PanelView Serial Firmware
Upgrade Utility

This chapter covers these topics:
W installing PanelView Sera FirmwareUpgrade Utility
w installing additional communicaion divers

w starting PanelView Serial FirmwareUpgrade Utility for the first
time

The Seral FirmwareUpgrade Utility Version 5(SRU32) is provided
on CD-ROM. The softwareinstalation program credes a diredory
on you hard drive for the SRU32 and copies al necessary filestoit.
By default, the drive and dredory is C:\AB\PB140(E\SFU32. You
can change this defaullt.

To install SFU32:

1. Start Windowvs NT or Windows 95. If youarealrealy in
Windows, close all open Windows applications.

2. Placethe CD-ROM inthe drive.

The CD-ROM begin shoud run automaticdly. If it does nat start
automaticaly, choose Run from the Start button and type

d: set up. exe whered is the drive containing the CD-ROM, or
seled setup.exe from Windows Explorer.

3. Inthe Welcome dialog box,click Next.

4. If youareinstaling onWindows 95,the Seled Version dalog
box appears. Seled Version 5,and then click Next.

If youareinstalling onWindows NT, the Selea Version dalog
box daes nat appear Version 5is automaticdly seleded.

5. Inthe Choaose Applications dialog box,chocse Seria Firmware
Upgrade as the applicaion youwant to install. You can chocse
more than ore applicaionto instal. Click Next.

6. Intheregistration window, enter your user name, company name,
and serial number and then click Next.

You can oltain registration information from the software
registration cad that is in you PanelBuilder 140@ padkage (A-B
Catalog Number 2711E-ND1).
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Installing SFU Version 3
from CD-ROM on
Windows 95 or
Windows 3.1 or later
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7.

10.

12.

In the confirmation window, verify the userinformation you lave
entered. Seled Yesto proceal o No to edit the userinformation.

The Welcome diadlog boxfor the Serid FirmwareUpgrade Utility
recommends that you close all open Windows applications. If you
have dore that, click Next.

Choaose the drive and dredory in which the SFU32 will be
installed. By default, this is C:\AB\PB140E\SRJ32. To change
the destination dive or diredory, type the new drive and/or
diredory in the Program Files field. Click Next.

Choase the program folder (program group) in which youwant to
install the SRU32 sicons, which includes a Readme file icon, the
Upgrade Utility icon, and an Uninstall icon. By default, theicons
areinstal ed in the PanelBuilder 140G program folder. Click
Next.

The setup uility shows asummary of the choices youmade in the
precaling dalog boxes. To make any changes, click the Back
button. Otherwise, click Next to begin the install ation.

Do na cancd theinstllationwhileit is in progress If youwant
to undothe instal ation, let the install ation finish, and then use the
Uninstall Serial FirmwareUpgrade Utility to remove al the
install ed files and to updite the registration.

When the install ation is complete, remove the CD-ROM from the
drive.

The Seria FirmwareUpgrade Utility Version 3(SFU) softwareis
provided onCD-ROM. The softwareinstall ation rogram credes a
diredory on you hard drive for the PanelView Serial Firmware
Upgrade Utility and copies all necessaty filestoit. By default, the
drive and dredory is C:\AB\PB140C\SFU. You can change this
default.

To install SFU:

1. Start Windows 95 a Windows 3.1 a later. If youarearealy in
Windows, close al open Windows appli cations.

2. Placethe CD-ROM inthe drive.

The CD-ROM shoud begin to run automaticdly. If it does nat
start automaticdly and youarerunning onWindows 95, chocse
Run from the Start button and type d: set up. exe whered is the
drive for the CD-ROM, or seled setup.exe from Windows
Explorer.
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If the CD-ROM does nat start automaticdly and youarerunnng
onWindows 3.1 a later, choose Run from the File menu. In the
Runwindows, type:

d: setup

whered is the drive containing the Panel View Seria Firmware
Upgrade Utility CD-ROM, and pressEnter.

Current Directory: C:AWINAPPS

Command Line:

| d-setup | Cancel

] Run Minimized

3. Inthe Welcome dialog box,click Next.

4. If youareinstalling onWindows 95,the Seled Version dalog
box appears. Choose Version 3,and then click Next.

If youareinstalling onWindows 3.1 @ later, the Seled Version
dialog box des nat appear Version 3is automaticaly seleded.

5. Inthe Choase Applications dialog box,chocse Seria Firmware
Upgrade as the applicaion youwant to install. You can chocse
more than ore applicaionto instal. Click Next.

6. The Welcome dialog boxfor the Serid FirmwareUpgrade Utility
recommends that you close all open Windows applications. If you
have dore that, click Next.

7. Choosethe drive and dredory in which the PanelView Seria
FirmwareUpgrade Utility will beinstalled. By default, this is
C:\AB\PB140G\SHU. To change the destination dive or
diredory, type the new drive and/or diredory in the Diredory
field. Click Next.

8. Choose the program folder (program group) in which youwant to
install the PanelView Serial FirmwareUpgrade Utility’s icons,
which includes a Readme file icon, the Utility fileicon,and an
Uninstall icon. By default, theicons areinstalled in the
PanelBuilder 140 program folder. Click Next.
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Installing SFU32 Version 5
from Floppy Disks on
Windows NT or

Windows 95
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9.

10.

Foll ow the setup instructions as they appearon you screen.

To compl ete the setup, enter any required information when
prompted.

Do na cancd theinstallationwhileit is in progress If youwant
to cancd theinstall ation, let the instal ation finish, and then use
the Uninstall Serial FirmwareUpgrade Utility to remove all the
install ed fil es.

When the install ation is complete, remove the CD-ROM from the
drive.

The Seria FirmwareUpgrade Utility Version 5(SRU32) softwareis
provided ontwo disks. Before installi ng the software make a backup
copy d the disks. Store the original disksin a safe place andinstll
the SRU32 from the copy.

The softwareinstall ation program credes a diredory on you hard
drivefor the SRU32 and copies al necessary filesto it. By default,
the drive and dredory is C:\AB\PB140(E\SFU32. You can change
this default.

To install SFU32:

1

Start Windowvs NT or Windows 95.1f youarealrealy in
Windows, close al open Windows applications.

Insert the floppy dsk in the drive.

Choose Run from the Start button, and type a: set up. exe where
a is drive for the floppy dsk drive, or seled setup.exe from
Windows Explorer.

Close al applications, and then chocse Next. The Serid
FirmwareUpgrade Utility Install ation Program runs
automaticaly.

Enter the required information.

Choase the drive and dredory in which the SRU32 will be
installed. By default, this is C:\AB\PB140E\SRJ32. To change
the destination dive or diredory, type the new drive and/or
diredory in the Program Filesfield. Click Next.

Choase the program folder (program group) in which youwant to
install the SRU32 sicons, which includes a Readme file icon, the
Upgrade Utility icon, and an Uninstall icon. By default, theicons
areinstaled in the PanelBuilder 140G: program folder. Click
Next.
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Installing SFU Version 3
from Floppy Disks on
Windows 95 or
Windows 3.1 or later

8. Follow the setup instructions as they appearon you screen.

To complete the setup, enter any required information and insert
the seoond dsk when prompted.

Do na cancd theinstallationwhileit isin progress If youwant
to undothe instal ation, let the install ation finish, then use the
Uninstal Seria FirmwareUpgrade Utility to remove all the
install ed fil es and to updhte the registration.

9. When the install ation is complete, remove the disk from the
drive.

The Serial FirmwareUpgrade Utility Version 3(SRU) softwareis
provided ontwo dsks. Before installi ng the software make a badkup
copy d the disks. Store the original disksin asafe place andinstall
the PanelView Serial FirmwareUpgrade Utility from the copies.

The softwareinstalation program credes a diredory on you hard
drive for the PanelView Seria FirmwareUpgrade Utility and copies
al necessary filesto it. By default, the drive and dredory is
C:\AB\PB140@\SFU. You can change this defaullt.

To install SFU:

1. Stat Windows 95 a Windows 3.1 a later. If youarearealy in
Windows, close al open Windows applications.

2. Insert the floppy dsk in the drive.

3. If youarerunnng onWindows 95, chocse Run from the Start
button, and type a: set up. exe, wherea is the drive for the floppy
disks, or seled setup.exe from Windows Explorer.

If youarerunnng onWindows 3.1 @ later, choose Run from the
File menu. In the Runwindows, type:

a:setup Or b:setup

wherea or b is the drive containing the Panel View Serial
FirmwareUpgrade Utility disk, and then pressEnter.

= Run

Command Line: oK

| a:setup| | Cancel

|:| Run Minimized Browse. ..

410
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Installing Additional
Communication Drivers
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4. A window appeals, recommending youclose all open Windows

applications. If youfollowed step 1, click Next; otherwise close
al open Windows appli cations now. Click Next.

Choacse the drive and dredory in which the Panel View Seria
FirmwareUpgrade Utility will beinstalled. By default, this is
C:\AB\PB140@\SFU. To change the destination dive or
diredory, type the new drive and/or diredory in the Diredory
field. Then click Next.

Choase the program folder (program group) in which youwant to
install the PanelView Serial FirmwareUpgrade Utility’sicons,
which includes a Readme file icon, the Utility fileicon,andan
Uninstll icon. By default, theicons areinstalled in the
PanelBuil der 140Ce program folder. Click Next.

Foll ow the setup instructions as they appearon you screan.

To complete the setup, enter any required information and insert
the second dsk when prompted.

Do na cancd theinstallationwhileit is in progress If youwant
to cancd theinstal ation, et the install ation finish, then use the
Uninstall Serial FirmwareUpgrade Utility to remove all the
install ed fil es.

When the install ation is compl ete, remove the disk from the
drive.

The PanelView Seria FirmwareUpgrade Utility suppats additi onal
communicaion divers besides the core drivers (Remote |/0O, DH+,
ControlNet KTCS, and ControlNet KTCX). If an additional driveris
suppated, a disk that contains an install and unnstall program is
supgdied in the kit for that network driver.

To install an additional driver:

1

Close the Panel View Serna FirmwareUpgrade Utility before you
install the driver.

Placethe floppy dsk in the drive.

On Windowns NT or Windows 95, click the Start button and then
choose Run.

On Windows 3.1 a later, choose Run from the File menu o
Program Manager or File Manager.
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Starting the PanelView
Serial Firmware Upgrade
Utility

4. Inthe Runwindow, type:

a:setup Or b:setup

5. Follow theinstall ationinstructions as they appearon you screen.

When the registration window appears, enter the registration
information that is provided in the kit for the network driver.

6. When the install ation is complete, remove the disk from the
drive.

7. Start the PanelView Serial FirmwareUpgrade Utility. The new
driveris displayed in the list of drivers.

This sedion describes how to start the utility from Windows NT,
Windows 95, o Windows 3.1 a later. The functiondlity of the serial
firmwareupgade utility is the same for Windows NT, Windows 95,
and Windows 3.1 a later.

To start the PanelView Serial Firmware Upgrade Util ity from Windows NT
or Windows 95:

1. Click the Start button onthe taskbar.

2. Choose Programs, and then chocse PanelBuilder 140@g, or the
folder you spedfied when youinstall ed the program.

3. Choose PandlView Serial FirmwareUpgrade Utility.

To start the PanelView Serial Firmware Upgrade Util ity from Windows 3.1
or later:

1. Doube-dick the PanelBuilder 140@ program group (or the
program group youseleded when youinstall ed the software)

2. Doule-dick the PanelView Serial FirmwareUpgrade Utility

icon.
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Performing a Serial
Firmware Upgrade

Exiting from the PanelView
Serial Firmware Upgrade
Utility
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After starting the Serial FirmwareUpgrade Utility, the PanelView
Seria FirmwareUpgrade Utility dialog boxappears.

To perform a serial firmware upgrade:

1. Choose Upgrade Paraneters.

2. Seled Communications Drivers.

3. Toinitiate the PanelView firmwareupgade, click Start Upgrade.

For more information on haev to configure parameters and initi ate a
firmwareupgade, pressri to open orline help.

During the firmwareupgade, the host computer displays status
information. If the upgade has been completed succes<ully, the
following message is displayed and the Panel View temminal reboats:

Term nal firmwvare upgraded successfully.

If the upgade fail ed, the following message is displayed and the host
computer returns to the Serial Firmware Upgrade Utility dialog box

Termnal firmwvare upgrade fail ed.
When you tave finished transferring the firmware youcan exit the

PanelView Seria FirmwareUpgrade Utility.

To exit from the PanelView Serial Firmware Upgrade  Utility:

Click the Exit buttonin the dialog box.
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A Brief Tour of PanelBuilder
1400e

This chapter introduces youto the basics of PanelBuilder 140Qe. It
covers these topics:

w credingand opening PanelBuilder 140Ce applications

w key conceptsto help you unerstand hav PanelBuil der 140G
works

w PanelBuilder 140G comporents and haw to use them

This chapter does nat provide a detail ed dscusson d how the
Windows operaing system works. If youareunfamiliarwith
Windows, referto you Windows documentation first

" Tip: Credeanew applicaion, a open ademo or tutorial
application, as described in the next two sedions. Follow alongand
lean about the program as you read the rest of this chapter.

Crea_ting_ a New To create a new application:
Application

1. Choaose New Applicaionfrom the File menu a [ from the

toolbar. Or, preSSCTRL+N.

The New Applicaion dalog boxappeas.

New Application... Ctrl+N

Mew Application H

Open Application... Ctrl+0

—Application Type:
Upload...
Download... 1000e [640x480] -l:am:el
— 1200e (640x480)
Exit Alt+F4 1400e (640x420)

1400e (800x600)

@ Keypad
() Touch Screen

Hetwork Type:
Remote 1/0
DH+
ControlNet
Modbus

" Note: In aPanelView 140@: applicaion, youcan switch from a
high resolution mode of 800y 600to a lower resolution mode of
640y 480,and vice versa.
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2. Seled the type of termminal the applicaionwill be running on.

Seled Remote I/O, DH+, ControlNet, or Modbus as the network
type.

Note: For information abou creding a PanelBuil der applicaion
for Modbus communications, seethe PanelBuilder 140G
Configuration Sdtware for Windows Modbus User Manud (A-B
Publication Number 2711E-6.12).

Important:  You canna convert a keypad applicdionto a
touch screen applicaion, a viceversa.
However, youcan switch between 100@&, 120G,
and 140@ application types, and youcan change
the appli cation’s network type.

Tip: Youcan copy dsplay objeds between applications for
different terminal types to reduce the amourt of time required to
crede a keypad appli cation from an existing touch screen
applicéion, a viceversa Seethe PanelBuilder 140G
Corfiguration Sdtware for Windows User Manud for detalls.

. Choose OK.

The Application Window opens inside the PanelB uil der 140G
Window.

<% PanelBuilder 1400e

File Screen Databaze Tool: ‘window Help

%4 Application - Untitled1
1000e Keypad (640x480). Remote IO, Private Tags

PLC Communications
System

Mezsages

£ Sereens
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Opening Applications

New Application... Ctrl+N
Open Application... Ctrl+0

Download...
Upload...

Exit Alt+F4

If you have existing PanelBuil der 140Ge, PanelBuilder for DOS, or
PanelBuil der 1200appli cations, youcan open them. For information
abou opening applicaions creded in aher versions of PanelBuilder,
seePanelBuilder 140G Configuration Sdtware for Windows User
Manud.

To open an existing application:

1. Choase Open Application from the File menu a = from the
toolbar. Or, presscTrL+0.

The Open daog boxappeas. It lists the avail able applicaionsin
the spedfied drive and dredory. If noapplications arelisted, you
may need to change the drive or diredory, or list anather type of
application, for example, a PanelBuil der for DOS .cfg
applicdion.

Open m
File name: Folders: 0K
I*,pvc o\ ahph400e\utarial
Cancel
WKCTUTOR PYC B EE 2] ‘:
MTCTUTORPYE = AB
MTUTORK.FVC (= PB1400E Help
MTUTORT.PYC g TUTORIAL -
TUTORK.PYVT
Metwork...
TUTORT.PVC et
Listfiles of type: Drives:
FanelBuilder (*pwc) j | B AJ

Tip: To open an existing application so youcan follow alongas
you rea this chapter, double-dick the PB140@: folder to dsplay
the DEMO and TUTORIAL folders, then doubbe-dick DEMO or
TUTORIAL and seled an applicdion.

Note: The TUTORIAL folder contains two Remote |/O
applicaions—one for keypad terminals and ore for touch screen
teminals, as well as four Modbus appli cations—two for keypad
teminals and two for touch screen teminals. The DEMO folder
contains two Data Highway Plus appli cations—one for keypad
and ore for touch screen terminals.
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Key Concepts
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2. Seled the applicaion youwant to open.
3. Click OK.

If your system does nat have enoughmemory to open the
application, the foll owing message appeass:

“PanelB uil der 140@ has deteded low memory resources”

You must close one or more currently open softwareappli cations
or currently open applications in PanelBuilder 140G, before you
can open another PanelB uilder 140Qe application.

To uncerstand hav PanelB uil der 1400 works, you reed to knaw the
foll owing concepts.

PanelBuilder 1400e Window

The PanelB uil der 140G Window is the firstwindow that appeais
when youstart PanelBuilder 140Ce. In it you crede and configure
applications.

&’ PanelBuilder 1400e
File  Help

NIE=

Application

An applicationis afilethat you crede and configure in PanelB uil der
140C:. You dawnload the completed applicaion to a Panel View
terminal, whereit appeass as a set of screens and screen comporents.
The operaor uses these componrents to monitor and control the
operaions of an automated processor machine.

For a detail ed example of a phaocopying applicaion, seethe tutorial
beginningin Chapter 6 d this manual.
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Application
Window

Application
Window

Folder

App lication Window

Ead application hasits own window that appeass within the
PanelBuil der 140G Window. This window is cdl ed the Application
Window. Throughit you can accessall the comporents that make up
asingle application.

anelBuilder 1400e

File Screen Database Tools ‘wWindow Help

4 Application - Untitled1
1200e Keypad [(640x480), Remote |f0, Private Tags

PLC Communications
Systern

Messages

1 Screens

The Application Window contains al the dialog boxes and editors
youwill useto buld and configure the applicaion. These are
contained in folders. The application’'s name s listed in the
Applicaion Window title bar, aswell asthe type of tag database
used. In this example, the database is private.

%4 Application - Untitled1
1200e Keypad [640x480). Remote IO, Private Tags

£2 PLC Communications

Dialog Box

Editor

F lﬁj Communication Setup

- &E5 Nodes

- I Scan Claszes

- L~ RIO Racks

- L2 RIO Block Transfer Files
LB scheduled Files

= System

F ,Q Terminal Setup

F g Tag Databaze

= Alarms

- &8 PLC 140 Contral

% Infarmation Message Window

- @ Alarm Messages

= @ Information Meszages
L (B Local Meszages
£ Screens
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Folders

The Application Window contains four folders, which contain
groupngs of editors or dialog boes.

This folder Contains

PLC Communications  Dialog boxes and editors for configuring communications with
the PLC. This includes setting up nodes and scan classes for
DH+, ControINet, and Modbus applications, and configuring
racks and block transfer files for Remote 1/0 applications.

System Dialog boxes and editors for configuring the terminal, tag
database, alarms, PLC I/0 Control options, and the Information
Message Window.

Messages Editors for creating information, local, and alarm messages.

Screens Application screens developed with PanelBuilder 1400e
software. There are no screens in a new application.

Dialog Boxes

Dialog bores areused to configure spedfic properties of the
application. For example, in the Configure Teminal Setup dalog
box, youassignthe Appli cation Startup screen and target firmware
version for the appli cation and spedfy timing parameters such as
hold timesfor push butons. Frequently, dialog boes arearranged
into tabs, acwrding to the type of information. For example, the
Configure Teminal Setup dalog box las a Generd tab, a Timing
Parameters tab and, for function-key applicaions, an Objed Setup
tab.

Editors

Editors arethe tods for creding and configuring the more complex
comporents of an applicaion in PanelBuilder 140Q. For example,
in the Tag Database editor you crede and edit tags. In the Messages
editors you crede messages that appearwhen the applicdionis
runnng. With the Expressins Editor you crede expressons to
manipulate the display of tag values at the PanelViewteminal and
reducethe complexity of PLC ladderlogic.
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Tag Database

Ead appli cation must have atag database. This database can be
spedfic to that applicaion (private), or commonto severd
applications (shareld). The tag database contains tags. Tags are
mnemonic representations of numeric addresses onthe PLC.

Ead tag is assigned an appropriate addresslocaionin the
programmable controller. In turn, the tags areassigned to oljeds,
[/O control options, and terminal windows. The same tag can be
assigned to severd objeds.

Application Screens

Applicdion screens contain oljeds the operaor uses to monitor and
control the process The applicaion screans youcrede in

PanelB uil der 140Ce appearonthe Panel View terminal when the
applicaionis runnng.

Alarm Scree ns

The Alam History and Alamm Status screens provide information on
alamsthat occur whil e the applicationis runnng.

Windows

System windows pop up orscreens when the applicaionis running,
providing information to the operé&or.

Althoughtherearea number of pre-defined system windows that can
appear the only ones you can configure in PanelBuil der 140@e are
the Information Message Window and the Alam Message Window.
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Screen Objects

Applicaion screans contain oljeds such as push buttons, bar graphs,
or screan seledors. These ohjeds replacethe comporents of
traditional control panels. Thereareseverd types of objeds:

W Input to programmable logic controller—Objeds such as push
buttons all ow the operaor to send information to the
programmable logic controll er.

w Display information from programmable logic
controller—Objeds such as bar graphs and multistate indicator
objeds display information from the programmable logic
controller.

w Screen change objects—Static objeds such as Goto Screen
buttons all ow the operator to control screen changes at runtime.

w Drawing objects—Static ojeds such aslines, text, and gaphic
images enhancethe appearance of the screen and provide
information to the operaor.

Objeds arecreded in the applicaion screen editor. You can also
import graphic images into the screen editor.

Working in the This sedion explains the feaures of the PanelBuil der 140G
PanelBuilder 1400e Window, and shows you hawv to use basic PanelBuil der 140G tods.

Window

The following ill ustration shows the PanelBuil der 140G Window
with an Application Window. All the elements contained in the
window areexplained in the next table.

Close Button

Title Bar Maximize Button

Minimize Button —‘

Control Menu <4 PanelBuilder 1400e
MenuBar —————— File Screen Database Tools Mindow Help

Toolbar — N EElEE R S EEE R E]

%4 Application - Untitled1
1200e Keypad [640x480), Remote IO, Private Tags

Mouse

pointer PLC Communications
o System

Ap_pllcatlon Messages

Window £ Screens

Window

Border

Status Bar— [ Downlaad an application to Panelview Terminal
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Element

How to use it

Minimize button

To reduce the window to an icon, choose g

Maximize button

To enlarge the window to its maximum size, choose @

Close button

To close the window without saving changes, choose IE

Title bar To move the window, click and drag the title bar.

Control box To open the control box menu, click the box or use ALT+SPACEBAR.
To close the control box menu, click outside the menu or press
ESCAPE.
To close the window, double-click the Control box.

Menu bar To open the menu and see the commands, choose a menu name
or use ALT+underlined letter.

Toolbar To carry out a command, choose an icon.

Application Window

To open folders, double-click them. Then you can launch editors or
open dialog boxes.

Mouse pointer or
cursor

To select or choose items, use the mouse pointer.

Window Border

To change the window size, click the border and drag it.

Status bar

To see what a menu command or toolbar icon will do, move the
cursor over the command or icon and read the description in the
status bar. When the Screen editor is active, the status bar also
shows the X and Y coordinates for the position of objects and the
pointer.

Restore button
(not shown in
illustration)

To restore the window to mid-size, choose

Youwill find more detail ed information onmost of these features
later in this chapter.
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Using the Menu Bar and Toolbar

Ead window in PanelBuilder 140G has amenu bar and tool bar.
(Diaog boyes do na have menus and tod bars.)

The menu bar and toolbar let you chocse and carry out commands.
The menu bkar has pul-down menus that contain commands.

Menu bar Screen  Database Took Window  Help
. Mew Application... Chrl+M : = '@\
File menu Open Applicatiar... Chrl+0
Save Application Chrl+5
Save Application Az,
Commands e Ctrl+F4
Download ..
Upload...
Exit Alt+F4
The todbar consistsof icons that carry out commands when you
click them. Ead icon corresponds to either a menu item or an editor
in the Application Window folders.
Toolbar ‘
~u 4 e
EEEEE BREEEERIEEEEIEERE
Icons

Youwill naticethat the menu bar changes as youwork in dfferent
editors within PanelBuilder 140(e.

Using the Status Bar

Eadc window in PanelBuilder 140G has a status bar. The status bar
informsyouabou PanelBuil der 14002 comporents, todls,
commands, and error messages.

For example, if you pesition the mouse painter over the icon,
the foll owing message appeais in the status bar.

| Save the current application
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Or, if youseled ascreen ojed in an applicaion screen, the status
bartells youwhat kind o objed you heve seleded, its position on
the screen, height and width, and state.

|| H=321%¥=164, Width 80 Height 60 S5tate: 0 Normally Closed Momentary Push Button

Working in the Application
Window

In the Screen editor, as you move the mouse painter, the status bar
displaysthe painter’s coordinates onthe screen.

To accessthe editorsin the Applicaion Window, youmust open the
folders.
Folders that look like this contain components.

= Folders that look like this are open.

T Folders that look like this are empty.

To open o close afolder, use the following methods:
W doule-dick the folder

W to open aclosed folder, seled the folder, then pressthe + key on
the keypad

W toclose an open folder, seled the folder, then pressthe — key on
the keypad

Starting Editors
You can usetwo dfferent methods to start an editor.

To start an editor;

W Click theicon d the editor in the todbar.
w Doule-dick the editor in the Applicaion Window.

Using Tabs in Dialog Boxes

Some dialog boxes have different categories of options or application
properties you can configure. These areorganized into tabs. You can
seled the tab youwant to work in, and configure the desired options.
Then, if youwish, youcan seled anather tab.

When youchoose OK, al the changesto all the tabsin the dialog
box areacceted. When youchoaose Cancd, the dialog boxcloses.
All changesto al tabs arelost
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For example, for a keypad application the Configure Temminal Setup
dialog boxconsistsof the Generd tab, the Timing Paraneters tab,

and the Objed Setup tab.

Configure Terminal Setup <]

This is the active tab JI’ T Timing Parameters T Object Setup ]

Application Startup Screen:

| Sercen | R |

Click on this to switch to Cancel

the Timing Parameters tab

Application Type:
‘ Type: | 1000e (640x480) Keypad |

Click on this to switch to
the Object Setup tab

Application File Comment:

Target Firmware Yersion:

‘ Yerzion: | 05.00 and up J

In the Generd tab youcan spedfy the Applicaion Startup screen,
seled the applicatlion type, enter an appli cation file comment, and
spedfy the target firmwareversion. In the Timing Paraneters tab
you can spedfy timesfor the different timing paranetersin the
application.In the Objed Setuptab, youcan set options that
detemrmine how some objeds behave at the temminal.

To switch between tabs:

Click the tab for the parameters youwant to configure, or hdd
down the ALT key, and pressthe undeilined charader.

Moving and Resizing Windows

You can move PanelB uil der 140G windows and dalog boxes
anywhereonthe screen.

To move a window:

1. Position the mouse panter onthe window’'stitle bar, and ress
the left mouse button.

2. While hdding davn the mouse button, dag the window to its
new pasition.

3. Release the mouse button.

" Note: Youcanresizeal editor windows, bu you cannd resize
dialog boes.
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To resi ze the window:
1. Positionthe painter over any bader or corner of the window.
The mouse panter changes to a doulie arrow.
2. Hold down the mouse button and drag the window to its newsize
3. Release the mouse button.

The following ill ustration shows the Appli caion Window after it has
been resized haizontally.

%4 Application - Untitled1
1200e Keypad [640x480), Remote {0, Private Tags

= PLC Commurications

= lﬁy Carmmunication Setup

- &%= Nodes

F M Scan Classes

- L~ RIO Racks

- LB RIO Block Transfer Files )
L Scheduled Files <» — Resize Arrow
= System

i% Temninal Setup

= g Tag Database

= Alarms

- &8} PLC 170 Control

= % Information Message Window

Meszages
T Screens

Working with Multiple App lications, Editors, and Screens

You can have severd applicdions, editors, and screans open at the
same time. This is useful if youwant to move or copy data from one
applicaion a editor to ancther, or accessinformationin severd
screens simultaneously.

The Window menu helps you ke track of what is open bylisting
ead open applicdion, editor, and screan.
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These windows are open

Publication 2711E-6.13 — November 1998

Which Window is Active?

Although youwcan have multi ple windows open, oy one window is
adive at atime. To enable youto identify the adive window, the title
bar of the adive window is highlighted, as the followingill ustration
shows.

i [LAkAIE), Ptz §12, Py Fags

) _-.-'H.'.'(r'—--rinﬂ

T RN Y ol O

R Rsihi
R0 Bk Tosiels Pl
e L

F

T Disbskeses

BT

PLE LT Cormet

P Plarages Yo

Active window

To see which window is currently active:

Choose Window in the menu har.

The Windowv menulists all open applications, editors and screens.
The adive window has a chedk mark (n ). For example, the
followingill ustration shows that the Appli cation Window for
Applicaion —BOTTLING is adive. The other windows arealso
open, bu arena adive.

Window
Cascade Shift+F4
Tile Shift+F5
Close All

Minimize Application
Minimize all
Arrange Icons

+ 1 Application - BOTTLING This window is active

2 Screens - BOTTLING - 1 Main
3 Screens - BOTTLING - 2 Pumps®
4 Screens - BOTTLING - 3 Valves™

5 Application - Untitled2
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To make another application, editor, or screen acti

W

ve:

Click anywhereonanather Appli cation Window, editor, or

screan.

Choose from the toolbar to adivate the Applicaion

Window correspondng to the adive

screen o editor.

In the Windowv menu, choose the name of the appli cation, editor,

or screen youwant to adivate.

A chedk mark (n ) appearss next to the name in the Window
menu. The screan, editor, or applicaion appearsin the
PanelB uil der window, with the title bar highlighted.

Arranging Multiple Windows

You can arganize your desktop by sing the Cascade and Tile
commands in the Window menu.

The Cascade command stacks and df sets the windows harizontally,
S0 youcan seetheir title bars. The Tile command arranges al open
windows astiles. The followingill ustration shows the Tile

command.
o el ol | i
[he Distinrn: o wmdoss Has
) (05 e

[t - 1T T1LIWG

e
e Madss

PN G e Clarsm

-~ FID Bachs

- B FED Banch, Timeske P
B ot Fisy

=
ﬁ-‘:rwu'.-m
- Tig Dalihine
E Alpm
- o FLC T Condaod
T mrairarars g 2 s T i
ElHll:lq::

: riwl) =
1200e Keypad [EAABDL Fmmnte Y8, Privain Tags

B PLE Conwrarscaions

WO | oy (o] ||

" Jowwems - ITIL RS - LW ={nfs]

D g
[ E<imam
= 5
To arrange open windows:
Choose Cascade or Til e from the Window menu.
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Reducing, Restoring, and Maximi zing Applications, Message
Editors, and Screens

An advantage of the Windows environment is that youcan have
severd windows open at the same time. But sometimes this can
clutter your workspace

To avoid clutter, reducewindowsto icons. This is cdled
“minimizing.” The followingill ustration shows the icons of a
minimized message editor, appli cation, and screen.

=

Local Messages - Untitled?

=i

Application - Untitled2  Screens - Untitled? - 2 PUMFS

To minimize a window:

| Cancade

| Tie

| Clomi &

| Hinimips &l

| 1 Apgcation - e
| ¥ Sermeni - Unifodi
: & Gerens - inif@ed D
| A Screens- Unifed] - TVALVESD
H O appdcation - Unied

Choose

in the titl e bar or choose Minimizefrom the

window’s Control menu.

To minimize an application and all its open screens
1. Click the application.

2. Choose Minimize Appli cation from the Window menu.

The application and all its screens areminimized into icons.

To minimize all open applications, editors or scree  ns:

| Arrange joam

Hlerard |

pelpiebl] » Choase MinimizeAll from the Window menu.

Theicons aredisplayed in the PanelBuilder window. If you have
many icons, youmay want to arrange them to avoid clutter.

& LIPS

1 A To arrange icons:

Choase Arrange Icons from the Window menu.

This arranges al iconsin arow at the batitom of the PanelBuil der

window.

When you reed to work in the appli cation, editor, or screen, restore
theiconto its original size

To restore an icon:

Double-dick theicon. Or, in the Window menu, seled the name
of the application, editor, or screen youwant to restore. Or, click
the icon and choaose Restore from its Control menu.
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File
New Application... Ctrl+N
Open Application... Ctrl+0

Download...
Upload...

Exit Alt+F4

& PanelBuilder 1400e
Restare
Mave

Magirnize:

Close  Alt+F4

To maximize a window or application:

Choose | in the window or choose Maximizefrom the

window’s Control menu.

Using Menus, Keys, and Icons

Menus contain al the adions or commands you can carly out in
PanelBuilder 140Ce. Icons onthe todbar aso perform cettain menu
commands. You can aso carty out some commands using the key
combinations shown in the menus.

To create a new application, use any of these metho  ds:

W Choose@ onthe todbar.

W Choaose New Applicaion from the File menu.
W Pressthe cTrL and N keys simultaneously.

Using the Control Menus

All windowvs and daog boxesin PanelBuilder 140G contain a
Control menu. The Control menu changes depending onthe window
you arein. Dialog boes contain only the Move and Close
commands.

T PanelBuilder 1400e
File Screen Database Toolz ‘indow Help

Close  CulF4

Next ChkFE

T

| Minimize the window to an ican

| Minirmize the windowto anicon
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This command Does this

Restore Restores the window to its previous size after you have
maximized or minimized it.

Move Allows you to use the keyboard to move the window or
dialog box.

Size Allows you to use the keyboard to resize the window.

Minimize Reduces the window to an icon.

Maximize Enlarges the size of the window to fill a larger portion of

the desktop or the entire desktop.

Close Closes the window or dialog box. In a dialog box, choosing
Close is the same as choosing Cancel. You lose any
changes made to dialog controls.

If you choose Close from PanelBuilder 1400e Window's
control menu, PanelBuilder 1400e closes.

Switchto. .. Opens a Task List dialog box that lets you switch between
running Windows applications. You can also use this
command to move between Windows and DOS.

Next Switches between an open editor and the Application
Window.

Using Help

You can use Help whenever you seeHelp onthe menu har, or seea
Help buton.

To access Help, do any of the following:

W Choose Help from the menu kar. This displays the Help menu.
Choose Help Index to goto the Contents window. Then seled the
topic youwant.

Pressr1 to display Help about the currently adive window.

Choase the Help command butonin dalog boxesto dsplay
spedfic information abou the dialog box.

Tip: Keep Help handy byresizing the Help window and moving
it next to the PanelB uilder 140G Window.
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Inside the Editors and
Dialog Boxes

= PLC Communications

B lﬁj Communication Setup

- ks Modes

- | Scan Clazzes

- [L~ RIO Racks

- U RIO Block Transfer Files
LI Scheduled Files

This sedion introduces PanelBuilder 140@’s editors and dalog
boxes and explains their main pupose. These arethe folders and
their editors and dalog bo»es:

PLC Communications

The PLC Communications folder contains these dialog boyes and
editors:

W

Communication Setup dialog box—In the Temminal
Communicaionstab of the Configure Communication Setup
dialog box, youset the baud rate for Remote 1/0 applications and
assgn the Panel View terminal network addressfor DH+ and
ControlNet applications.

Note: To transfer the application over DH+, Control Net, or
Remote /O Pass Throughwith the terminal in Run mode, you
can configure the terminal’s locaion routing addressand transfer
control tagsin the Network File Transfer tab. For more
information abou transferring appli cations with the temminal in
Run mode, seethe PanelView 100G, 120G, and 140@ Operator
Terminals User Manud, and the Panel View e Transfer Utility
User Manud.

Nodes editor—In the Node editor you set up nock definiti ons of
the devices the termina will communicae with onthe DH+ or
ControlNet network. Your applicaion’s tags will referto these
devices.

Scan Classes editor—In the Scan Classeditor you cefine the
rates at which the tags arescanned for DH+ or Control Net
applications.

RI0O Racks editor—In the Radk editor you seled the Remote 1/0
deviceand assgnthe radks your applicationwill use. The radks
you assgn determine the block transfer fil es and tags you can
crede.

RIO Block Transfer Files editor—In the Block Transfer editor
you can assign upto 64 bock transfer fil es of upto 64words
ead. Block transfer fil es provide more addressspacefor tags. In
this editor you can also configure the Pass ThroughControl byte
for Remote 1/0O Pass Throughappli caion fil e transfers.

Scheduled File editor—In the Scheduled File editor you cefine
the size of the read and write files for ControlNet Scheduled
Mode.
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= System
9 Terminal Setup

g Tag Databaze

Alarms

= FLC 140 Cantrol

% Infarmation Meszzage Window

= Meszages

|E @ Alarm Meszzages

@ [nfarmation Meszages
(B Local Meszages
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System

W

Configure Terminal Setup dialog box—In the Configure
Teminal Setup dalog box youcan describe the applicaion, set
timing parameters such as push buton hdd times or auto-repea
rates, assgnthe Application Startup screen, seled a different
applicaiontype, and spedfy the target firmwareversion. For
keypad applicaions, youcan aso spedfy default settings for
objed behavior.

Tag Database editor—In the Tag Database editor you can crede
and edit tags and tag folders.

Alarms dialog box—In the Configure Alamms dialog box you
can asspn aam tags, and configure the Alarm History and
Alam Status screens and the Alam Message Window.

PLC I/O Control dialog box—In the PLC 1/O Control dialog
box youspedfy whether the PLC monitors and/or controls certain
teminal functions. For example, the PLC-Controlled Screen
Number option al ows the PL C to control which screen appeais
ontheteminal.

Information M essage Window dialog box—In this dialog box
you can enable the Information Message Window, spedfy how
the window is removed, configure its appearance, and assign tags.

Messages

Messages inform the operaor about what is happening when the
applicationis runnng. For example, if a pump fails or atank is
amostfull, the operaor shoud be informed.

W

Alarm Messages alert the operaor to problemsin the process
Alam messages can appearin the Alamm Message Window that
pops up ower the appli caion screen. Alarm messages have spedal
optionsto alert the operaor. They can trigger audio dams,
energizerelays, adivate the printer, send a message to the PLC,
or be displayed in the Alarm Message Window.

Information M essages inform the operéor abou the status of
the operdion and provide prompts, instructions, or wamings.
These messages appearin the Information Message Window that
pops up ower the applicaion screan.

L ocal Messages inform the operaor abou the status of screen
operaions or provide prompts and instructions. Unli ke alam and
information messages, locd messages arenat displayed in popup
windows. Instead, they appearin Locd Messge Display objeds
in screens.
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= Screens Screens
1 MAIN . - :
g 2 PLMPES Use the Screan editor toals to creae the appli cation screans that will
BB 2valvES appearwhen the applicaionis running onthe Panel View terminal.
BB 4ROTATOR
Closing Editors and Thereareseverd methods to close editors and appli cations.
Applications . o _
To close editors and applications do any of the fol ~ lowing:
w Doube-dick the Contral box.
W Choose Close from the Control menu.
W PresscTtrL+F4. To close the Tag Database, RIO Radks, Block
Transfer Files, and Node editors, presSALT +F4.
w If the editor or applicaionis the adive window, chocse Close
from the File or Screen menu.
W Toclose al open applications, message editors, and screans,
choose Close All from the Window menu.

Exiting PanelBuilder To exit PanelBuilder 1400

Choaose Exit from the File menu, a double-dick in the Control
box d the PanelBuilder 140G Window or preSSALT +F4.

If applications areopen when youchoase Exit, they will al close
New Application... Ctri+N when youexit PanelBuilder 140@e. If the appli cations contain
Open Application...  Ctrl+0 unsaved changes, PanelBuilder 140@ will prompt youto save the
Save Application Ctrl+5 changes.

Save Application As...

Close Ctrl+F4
Download...

Upload...

Exit Alt+F4
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Purpose of the Tutorial

Introduction to the Tutorial

This chapter introduces you to the application youwill be working
with in this tutorial. It covers these topics:

W what the existing application daes, and hav youwill enhanceit

W the functions of ead applicaion screen and the uses of eat
objed

This tutorial is also avail able in Modbus Programmable Controll er
format. For information about running this tutorial with Modbts, see
the Panel Buil der 1400 Configuration Sdtware for Windows
Modbuws User Manud (A-B Publication Number 2711E-6.12),
suppied as patrt of the optional Modbus Communicaions Kit, A-B
Catalog Number 2711E-UMOD.

This tutorial is designed to get you started with PanelBuilder 140062
quickly and easily. This chapter provides an owverview of the tutorial.
Chapters 7, 8,and 9 povide instructions for adding ofjeds to the
existing screans. Chapter 10 shows you hav to add messages.
Chapter 11 shows you hav to dovnload the fil e to the Panel View
terminal, so youcan runit.

A second pupose of this tutorial is to show goodapplication design
principlesin adion.

Note: If youwant to runthe completed applicaionwithou creding
any o it yourself, youcan doso. Simply goto Chapter 11 and follow
the instructions for downloading the file. Then runit onthe temminal.
You can dothis at any pdnt in the tutorial.
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Before You Start Before you start the tutorial, ensure you have dore the foll owing:

w installed the Tutorial files. These contain the application fil es that
youwill need for the tutorial. For more information, see
Chapter 2.

w familianized youself with PanelBuilder 140@ basics. To dothis,
read the first part of this manual.

Also, ensure that you have the required equipment. You will need:
W PanelBuilder 140G instaled

W aPanelView 100G teminal, or an enhanced Panel View 1200
SeriesF or latertemminal, or a PanelView 120G terminal, or a
PanelView 1400 teminal

w PLC controller

" Note: Theladderlogic for this applicaionwas developed ona
PLC 5/15. You can usethe ladderlogic onany PLC controller that is
compatible with the PLC 5/15.

Understanding the This tutorial is based onthe foll owing scenario.

Scenario
You have an existing applicaion, creaed with PanelBuilder 1200,

that runs a paper copying grocess The madiine controlled bythis
applicationis alower-end model and daes nat have a stapling
feature.

You have dedded to purchase a new machine that suppats stapling.
To usethis feaure, youmust add the required controls to you
existing PanelB uil der 1200appli cation. As well, youredize that
your existing appli cation is nat as well-designed asit could be. You
want to finetune it to make it easierto use, andto improve the
appearance of the appli cation with more colors and better graphics.

To dothese tasks quickly and efficiently, you rave purchased
PanelB uil der 140G Configuration Softwarefor Windows.

This chapter of the tutorial gudes you throughthe existing
application, the applicaion screans, and the oljeds ead screen
contains. It explains how the objeds enable youto control and
monitor the copying rocess

It also oulinesthe olyeds youwill add.
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Starting To dothis tutorial, youmust have PanelB uil der 140G and the
PanelBuilder 1400e tutorial files install ed.

To start PanelBuilder from Windows NT or Windows 95

1. Click the Start button.

2. Choose Programs then choase the PanelBuil der 140@e folder.
3. Choacse PanelBuilder 140(e.

The PanelB uil der 140G Window appeais on you screa. You are
realy to begin working in PanelBuil der.

To start PanelBuilder from Windows 3.1 or later:

Doule-dick the PanelBuilder 140@ icon.

The PanelBuilder 140G Window appeass on you screan. You are
ready to begin working in PanelB uil der.

You must open your existing PanelB uilder 1200appli caion.

To open the application:

New Application... Ctrl+N

Open Application... Cirl+0 1. Choase Open Application from the File menu, a choose (=2
%ur;m;ad... onthetodbar. The Open dialog boxappeas.

Upload...

Exit Alt+FA 2. Spedfy the drive and dredory wherethe tutorial is located. If

you followed the install ation defaults, this will bein the
C:\AB\PB140E\TUTORIAL diredory.

Because the existing appli cation was creded using PanelB uil der
1200,it hasthe file type *.pbw

3. InthelList Files of Typefield, seled *.pbw.

Youwill seetwo applicaions. The one you choaose depends on
your PanelViewteminal type:

W kec-tutor.pbw—choaose this if you have a keypad terminal

W tc-tutor.pbw—chocsethis if you rave atouch screen temminal

Open EHER
File name: Eolders:
I*_pbw chabipbl400ehtutorial

KC-TUTOR, PR = =R = _
TC-TUTOR. FBYY = AB
= TUTORIAL
Listfiles of type: Drrives:
FanelBuilder 1200 {* phw) |l I o ;IJ
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4. Seled the appropriate applicaion.
5. Click OK.

A message appeass, informing youthat converting the applicaion
will make it compatible with PanelView 140Ce Version 1and
later firmware

Import Application [ x]

The version compatibility of this application will be set to
@ PanelView 1400e terminal firmware version 1.00.00 and above.
The application size may be increased as a result.

Convert application?

| OK || Cancel I | Help

6. Click OK.

A dialog boxappears, informing you @ the conversion status.

Priicensing soimeng

-

When the conversionis finished the Applicaion Window appeass.
The applicaion's name is displayed in thetitle bar.

Note: This applicaionis configured for Remote 1/0. Although you
could switch network typesto DH+, ControlNet, or Modbus, for the
purpose of this tutorial the appli caion remains configured for
Remote 1/0.

Before you start editing it, save the applicaion.
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New Application... Ctrl+N

Open Application... Ctrl+0

Save Application Ctrl+5

Save Application As...

Close Ctrl+F4
Download...

Upload...

Exit Alt+F4

Viewing the Application
Screens

E= Scieens
BB 1IMITIAL SCREEN
BB 10SETUPLEPRINTING
BB 40 COPIER OVERVIEW
BB 50REFPORT

To save the application:
1. Choose Save Applicdion As... from the File menu.

2. Spedfy the drive and dredory whereyouwant to save thefile, or
accet the default diredory.

3. If youwant to rename the file, type a new name for your filein
the File Name field. Or, you can save the applicaion unckrthe
existing nrame. Because it will be saved uncer a different file
extension, it will nat overwiite the existingfil e.

4. Click OK.

Note that PanelBuilder 140C automaticdly adds .pwvc asthefile
extension.

Onceyou lave saved your file, youcan start editing it. You can go
direaly to Chapter 7 and continue the tutoria, but we recommend
that you complete this chapter first because it guides youthroughthe
existing screans and explains how the objeds work. In addition, it
explains the feaures youwill be adding to enhancethe application.

The copier appli cation contains four appli caion screens:
W Initial Screen

W Setup&Printing

w CopierOvewiew

W Report

Initial Scree n

This is the first screen that appears when youstart the application on
the PanelView teminal. It introduces youto the applicaion andto
the copier—the Kodiak Duplicator.

To view the Initial Screen:

1. Openthe Screansfolderin the Applicaion Window. Youcan
douHle-dick it with the mouse painter, or use the dowvn-arrow key
to seled it and resSSENTER.

The folder contains four screans.

2. Doube-dick Initial Screen, o seled Initial Screen and ress
ENTER.

The screen appears, entitled “ Screans - [name of application] -1
INITIAL SCREEN.”
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" Note: All ill ustrationsin this chapter areof touch screen applicaion
screans. The remaining chaptersin this tutorial show the keypad
applicaion screans.

Sereens - TC-TUTOR - 1 INITIAL SCREEN *

Text

Date Display

Time Display

Goto Screen Buttons

Multistate Indicator

Text Label

Objectsand their Functions

This screen contains five types of ohjeds. The table lists the objeds
and haw they function when the applicaionis runring:

Object Function

Goto Screen Buttons (2) Each button is configured to call up a different screen on
the terminal. At runtime, when the operator presses a
button or its corresponding function key, the appropriate
screen appears, replacing the current screen.

Multistate Indicator (1) This object indicates to the operator that this screen is the
currently selected screen.

Time Display (1) This object displays the current time.

Date Display (1) This object displays the current date.

Text and Text labels These describe the application and objects.
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What You Will Need to Add

Althoughthis is a very basic scree, its design could be improved.
The application hesatota of five screens—four applicaion screans
and the Alarm History screen. The Initial screen all ows youto move
only to the Setup&Printing and the Copier Overview screans. You
shoud ke able to cdl upall four screans from this screen.

Youwill add two Goto Screen buttons to this screan. Chapter 7
provides step-by-step instructions for daing this.

The Initial Screan’s appearance could aso beimproved. Becaise you
can nav import AutoCAD (.dxf) and Btmap graphicsinto you
applicaion screens, you can import an image of a phdocopier to
liven upthe screen.

Setup& Printing Screen

Next, open the Setup&Printing Screen. Referto the previous sedion
for instructions on ogening the screen.

This screen enables youto control the printing ogions. You can
choase the paper size, number of copies, copy quality, zoom, and
copying mode. You can also start, reset, and cancd copying.

Screens - TC-TUTOR - 10 SETUP&PRINTING * MEE]

—Copies

KODIAK Duplicator————=Sptup Screppe———

—UE s e = S

—Copy —Z00M —Staple —Control-

Print

MM/ DD/ YY==HH: MM: S5_P

= -

e |

E=T, - B O |
T O +Wn = ™

L - — P — R 4
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Objectsand their Functions

This appli cation screen contains many dfferent obeds, with
different functions. Some ohjeds aregrouped together acoording to
their functions. The foll owing tables and ill ustrations show the
groupngs of ohjeds that function together to enable youto control
celtain aspeds of the process

" Note: Most of the objeds shown aretext and lines. These arenat
labeled.

Number of Copies—These objeds enable youto spedfy and then
monitor the number of copies being printed.

—Copies
Numeric Data Display —}—— NNN
Increment Value Button ——— + | — |
Decrement Value Button
Object Function
Numeric Data Display Displays the number of copies you have chosen.
(Copies Display)
Increment Value Button Press this button or the corresponding function key to
(Copies Increment) increase the number of copies.
Decrement Value Button Press this button or the corresponding function key to
(Copies Decrement) decrease the number of copies.

Copy controls—This group d objeds enables youto seled the
paper size, copy quality, and the copying mode. This group consists
of threeControl List Seledors withou Enter keys.

op!
Mlpper B Control List Selector
bLower i > without Enter Key
4 | n
0
u khark PMi:l N
a PHorm P2 0 _
Control List Selector 1 »Light »2:2 d Control List Selector
without Enter Key i g without Enter Key
el e
y _* *
[
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Object

Function

Control List Selector
without Enter Key (Paper
Bin Selector)

Choose between the Upper Bin (8.501y 11[]paper) and
the Lower Bin (1101 y 17[paper). Press the Down Cursor
button or the corresponding function key to make the
selection.

Control List Selector
without Enter Key (Copy

Quality)

Choose how light or dark a copy you want to make. There
are three settings, from light to dark. The default is normal.
Press the Down Cursor button or the corresponding
function key to move through the list and to make the
selection.

Control List Selector
without Enter Key (Copy
Mode)

Choose how you want to copy the document: from 1-sided
to 1-sided; from 1-sided to 2-sided; or from 2-sided to
2-sided. Press the Down Cursor button or the
corresponding function key to move through the list and to
make the selection.

Note: Ead Control List Seledor withou Enter Key in this tutorial
consistsof aList comporent and a Down Cursor button. The
followingill ustration identifies the comporents of the Copy Qudlity
Control List Seledor without Enter Key.

List component

Down Cursor button

pDark
PHorm
MLight

4

Zooming—These ohjeds enable youto chocse whether youwant to
increase the magnification d the copies, or decreae the zoom. You
can chocse from alist of zoom options. Then, if youwish, youcan
finetune these to the exad zoom you want.

00—
Numeric Data Display NNHNN
Normally Open
F »20B8Y% C Momentary Push Button
i w15ex u
X rl10ey 5
Control List Selector e 387 t
(without Enter Key) d » 25% 0
’ W
e | Normally Open

Momentary Push Button
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Object

Function

Numeric Data Display
(Zoom)

Displays the zoom you have selected for the document.

Control List Selector
without Enter Key (Zoom
Fixed)

Choose the zoom option you want for the document, from
25% to 200%. The default is 100%. Press the Down
Cursor button or the corresponding function key to move
through the list and to make the selection.

Normally Open Momentary
Push Button (Zoom
Increment)

Press this button or the corresponding function key to
increase the zoom by single percentages.

Normally Open Momentary
Push Button (Zoom
Decrement)

Press this button or the corresponding function key to
decrement the zoom by single percentages.

" Note: Thisis an example of acomplex ohed that is creded ou of

severd simple ojeds.

Print, Reset, Cancel—These olhjeds enable youto control the

copying:

Normally Open
Momentary Push Button

Normally Open

Momentary Push Button =~ —— 4
Cancel

Object

g Frint

Interlocked Push Button ~——}— E

=Control=

Function

Normally Open Momentary
Push Button (Print Button)

Press this button or the corresponding function key to start
copying.

Interlocked Push Button
(Reset Button)

Press this button or the corresponding function key to reset
the selected number of copies back to zero.

Normally Open Momentary
Push Button (Cancel
Button)

Press this button or the corresponding function key to
cancel the copying.
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M essages area—T his objed informsyou d the copier’s status:

Line

Local Message Display

Date Display

MM/DD/Y¥==HH: MM, SS_P

Time Display

Object

Function

Local Message Display
(Copy Messages)

Displays messages about the status of the copying
process. For example, while the copier is copying, the
message display will read “Copying.”

Date Display

This object displays the current date.

Time Display

This object displays the current time.

Goto Screen buttons—This applicaion screen contains buttons that
alow youto move between screans. It also includes a Multistate
Indicator that shows the currently displayed screen.

Goto Screen Buttons

Multistate Indicator

Object

\
e M ™

Function

Goto Screen Buttons (4)

Each button is configured to call up a different screen on
the terminal. At runtime, when the operator presses a
button or its corresponding function key, the appropriate
screen appears, replacing the current screen.

Multistate Indicator (1)

This object indicates to the operator that this screen is the
currently-selected screen and cannot be called up.
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Text

What You Will Need to Add

This screen contains all copying controls. Therefore youwill need to
add the stapling feaure hereas well . Fortunately, the designer of the
existing applicaion redi zed that this function would someday be
implemented. As you can seg asedion d the screen hes already
been designated for the stapling feature.

Youwill credeaControl List withou Enter Key objed that lets the
operaor chocse whether or not the copies will be stapled. Chapter 8
provides step-by-step instructions for creaing and configuring this
objed.

Copier Overview Scree n

This screan al ows you to monitor the different parts of the copier,
and seewhether ead part is functioning propeny.

Secreens - TC-TUTOR - 40 COPIER OVERVIEW* EEH|

KODIAK Duplicatope——————(yeryjpy Screen=——

/

Multistate Indicators

Feedep Top Exit Finisher

\ L7

Bar Graph

Goto Screen Buttons

! !
n/a [I:D n/a n/a
| i

I

Upper Bin Full Illl-.
I
Lower Bin Full I-b- n/a
I I
Printer /

oy

|

\ \
™ ™

Multistate Indicator
Lines

/
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All the parts of the copier arelabeled. Whil e the copier is adive,
these labels and their correspondng oljeds show the state of that
feature.

For example, if a paper jam existsin the Top Exit, the two Top Exit
Multistate Indicator ojeds will looklike this:

This allows youto pinpant the locaion d problemssuch as paper jams

Objectsand their Functions

Multistate Indicator Objects—The Copy Overview Screen
contains twelve Multistate Indicaor objeds: Feealer (2); Top Exit
(2); Finisher (2); Printer (2); Upper Bin (2); Lower Bin (2).

The objeds change state depending onwhat is happening in the
process The Fedler, Top Exit, Finisher, Printer, and Upper and
LowerBin oljeds operaein pairs: A Multistate Indicator objed in
the copierill ustration, and a correspondng label. Eat oljed is
configured to display four states (0 to J).

The states of ead oljed pair areconfigured to change
simultaneously. For example, when the Feeder M ultistate Indicator
objed in the copierill ustrationis at State 3, the Feeder label
Multistate Indicator ohjed is aso at State 3. The following table
shows the meanings of the four states for eath of these Multistate
Indicator objed pairs:

This Appears like this And means this
state

State 0 n/a (light grey on blue) ~ The component is not active (n/a).

State 1 OK (blue on white) The component is active and there are no
problems.

State 2 Alert (black on yellow)  Warning: Servicing will be required soon. (For
example, toner may be low.)

State 3 Jam (white on red) There is a paper jam in this location.
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The Upper Bin and Lower Bin oljed pairs areconfigured to indicate

the paper supdy. The following table indicaes what ead state
means and haw it is configured.

This Appears like this And means this
state

State 0 Full (light grey on blue)  Paper supply is full.
State 1 OK (blue on white) Paper supply is medium/full.
State 2 Low (black on yellow) Paper supply is low/medium.

State 3 Empty (white on red) Paper supply is empty.

Bar Graphs—These objeds areconfigured to show the amourt of
paperin ead o the paper bins. Whil e the copieris adive, the bar
graph shows how the amourt of paperis decreaing.

Full

Upper Bin Vertical Bar Graphs

Lower Bin 4
Full

L] ]

Goto Screen Buttons—This appli cation screen contains buttons that
alow youto move between screens. It aso includes a Multistate
Indcator that shows the currently displayed screen.

Goto Screen Buttons

Report

Multistate Indicator

Object Function

Goto Screen Buttons (4) Each button is configured to call up a different screen on
the terminal. At runtime, when the operator presses a
button or its corresponding function key, the appropriate
screen appears, replacing the current screen.

Multistate Indicator (1) This object indicates to the operator that this screen is the
currently selected screen and cannot be called up.
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What You Will Need to Add

You redd to add a stapler feature that will indicate when thereare
problemsin the stapler area such as the stapler being ou of staples.
To dothis, youwill addtwo Multistate Indicaor oljeds. These will
operae as a pair, exadly like the other six Multistate Indicator objed
pairsin this screen.

Chapter 9 provides step-by-step instructions for creaing and
configuring the two Multistate Indicators.

The Reports Screen

This screen enables you to view the number of pages that have been
copied, bah single- and doulbe-sided, in ead shift, aswell asthe
day’stotal. It also records problemsthat have occurred during the

day.

Screens - TC-TUTOR - 50 REPORT * !EII!I

KODIAK luplicatop————5tatus Reporf—

Production Totals

Lines Shift 1 Shift 2 Total
Text Copies
Single Sided NNNNN NNNNN NNNNN
Double Sided NNNNN NNNNN NNNNN
Total Copies NNNNN NNNNN NNNNN
Numeric Data Display Objects
Errors
Feeder NNNNN NNNNN NNNNN
Top Exit NHNKN NNNNN NNNNN
Finisher NNNNN NNNNN NNNNN
Printer NNNNN NNNNN NNNNN
Sorter NNNNN NNNNN NNNNN
Stapler NHNKN NNNNN NNNNN
Total Errors NNNNN NNNNN NNNNN wl

Multistate Indicator

Goto Screen Buttons

Sctir O view SO et SO 1

oin
l

l l |

Screen Print Button
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Objects and their Functions

Object Function

Numeric Data Display Display the totals (of copies and errors).

objects (30)

Screen Print Button (1) Press this button or the corresponding function key to

create a print-out of the screen.

Goto Screen Buttons (4) Each button is configured to call up a different screen on
the terminal. At runtime, when the operator presses a
button or its corresponding function key, the appropriate
screen appears, replacing the current screen.

Multistate Indicator (1) This object indicates to the user that the Report screen is
the currently selected screen, and cannot be selected.

You do no need to add any oljeds or enhancements to this screen.
This screen simply demonstrates how you can use ohjedsto kegp
tradk of your process
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Creating and Configuring
the First Goto Screen
Button

Creating Buttons and
Importing Graphics

This chapter shows you hav to add two Goto Screen butons to the
Initial Screen. It includes these topics:

W credingthe butons
W resizing, moving, and configuring the appearance of the buttons

This chapter also provides instructions for adding a graphic imageto
the screen.

When the applicaionis running onthe Panel View terminal, the
operaor uses Goto Screan buttons to change to ather applicaion
screans. The operaor can cdl up oy the Setup and View screans
from the Initial Screen. However, the application has two more
screans: the Report and Alam History screens. You want the
operaor to be ableto cdl upall four screans.

To enable the operaor to dothis, youwill add two Goto Screen
buttons.

Soreens - KC-TUTOR - 1 INITIAL SCREEM *

KODIAK o 8

Duplicator

Note: Thisandall following screen ill ustrations areof keypad
application screans. Touch screen applicatiion screens do nd show
function key designations and the buttons arepasitioned further

apart.
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If theInitial Screen is nat arealy open, follow the instructionsin

Chapter 4 and ogen it.

Creating the Goto Screen Button

To create a Goto Screen button:

1. Choose Screen Seledors from the Objeds menu and chocse
“Goto Screan” Button, a sded I from the toolbox.

+ Select
Push Buttons
Control Selectors
Indicators
MNumerics
Trend
Bar Graphs
Time and Date
ASCIl Input
Scrolling List
Symbol...
Local Message Display
ASCIl Display
Goto Configure Mode

b . .

b . .

Screen Print Button

Screen Selectors 'Goto Screen' Button

'Beturn to Previous Screen' Button

Graphic Image
Drawings
Text

Screen List Selector
Screen Keypad Enable Button

Curl+T ]

When youmove the painter to the screen, youwill seethat it has
asmall sguareat its base. This meansthe ohjed tod is adive.

2. Position the panter whereyouwant to draw the new button.
Pressand hdd the left mouse button whil e you dag the mouse.

The button appeass, in default size You will natiicethat this
button is somewhat larger than the existing Goto Screen bittons.

Existing |
Button 1EW
Fil

New
Button
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3. Click oncein the screen to exit button-draw mode.
Tip: You can reverse any changes youmakein ascrean. Choaose Undo
from the Edit menu, | ﬂ from the todbar, or presscTrL+z.

If you cedde that youwant to reverse the undo, youcan doso. Chocse
Redo from the Edit menu, E from the toolbar, or presscTrL+.

Resizing the Button

To keep the new button's appearance consistent with the existing
buttons, resizeit.

Tip: Before yousizethe button, seled an existing buton. The status
bar shows its width and height. You mustresize the new button to
this size

To resize the Goto Screen button:

1. Positionthe painter onthe button and click the left mouse button.
Handles appearonthe button, indicating that it is seleded.

/ [ ] | | | ]
Handles =

2. Positionthe painter over the upper midde hande. Youwill natice
that the painter changes to a bi-diredional arrow.

3. Pressand hdd the left mouse button while you dag the panter
downwards.

The outline of the button foll ows the movement of the painter. If
you areworkingin a 120G touch screen applicaion, the outline
will move by touch cdl boundaries only. When the status bar
indicates that the button is the same size as the existing butons
(Height 40), release the mouse button.

If you applicationis for a keypad terminal, resize the button
horizontally until its width is approximately 64 pxels.
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Creating Buttons and Importing Graphics

I oreqrosad Coler
Backgmund Color

o Smadl Famd
Double ‘Yide Fom
kil digh Fom
Large Fuil
Exfiin Listjje Fisal

Fluillion sbveggin

Line Biyle

Fill Eigle
Hiink
Undoding T
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«Halaed T
Haised &
Flajmed &
Falppd &
Faiugd 18
Raised 17
Flalned lasef
Insel

Moving the Button

Unlessthe buttonis alrealy pasitioned corredly in the row of
buttons at the battom of the screen, move the button.

To move the button:

1. Positionthe panter over the button and click to seled it. While
holding dovn the left mouse button, dag the mouse.

2. Asyou dag the mouse, the button moves. Drag the button so it is
positioned next to the View button, and release the mouse button.

Tip: If you applicationis for a keypad termina, youwill assign
Function Key 12to this button. To ensure that the button aligns with
this function key, choose Zoom Out in the View menu. This displays
the function keys as they appearona keypad terminal. If the button
is nat aligned properly, moveit. To restore the screen to its normal
size, choose Zoom In from the View menu.

Changing the Button Appearance

To keep the button's appearance consisent, youmust add text to the
button and change the color and bader style.

Changing the Border Style

When youconwert an appli cation, existing butons areassigned
border styles automaticdly. You will naticethat the new buton's
borderis different from the existing buton baders. To stay
consistent, assgn the same border to the new button.

To change the border style:
1. Seled the new Goto Screen buton.
2. Choose Border Style in the Format menu, and choose Raised 2.

The barder onthe button changes to the same style as the existing
buttons' borders.
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tepor
Fl2

Adding Button Text

This button's functionis to cdl upthe Report screen. You must add
text to the button to indicate to the operaor that it will cdl upthis
screen. When youadd text to a button youcrede an ojed label.

To add text to the button:

1

Choaose Text in the Objeds menu a E from the toolbox. Or,
PresSCTRL+T.

The painter changes to an I-bean.

Position the I-beam in the left side of the button. Click the left
mouse button. Now, type Report .

Tip: If you dd na pasition the text far enoughto the left, you

may nat be ableto fit al the charadersinto the button. To fit all

the text in the button:

w click the text ohjea with the right mouse buttonto seled it

W move thetext objed to the left

w click thetext again with the right mouse buton to enter text
mode

W type the remaining text

If your applicaionis for a keypad terminal, youshoud indicae
which function key the user must pressto cdl upthe screen.
Position the I-beam onthe battom of the buton, click, and

type F12.

When youarefinished, exit Text mode. You can dothis by
choasing E in the todbox, clicking the right mouse button,

doule-dicking in an empty spat onthe screen, o pressngEesc
twice

Note: If the text's redangle overaps the shadow onthe buton's
border, change the text’sfill styleto hdlow:

W seled thetext
w choose Fill Style from the Format menu
w seleda Hollow

Publication 2711E-6.13 — November 1998



7-6 Creating Buttons and Importing Graphics

Changing the Color

You can change the objed’s colors by choasing Foregroundand
Badkgroundcolors from the Format menu, a you can use the color
palette. The toprow of the palette configures the button's foreground
color (text), and the battom row configures the button's badkground
color (the buttonitself). The two ovedapping squares at the far left

of the palette show the seleded colors.

M [ T [ Coreoround olors
Selected colors —ﬂ

—— Background colors

To change the button’s color:

1. If the color palette is not on you screen, choase Show Color
Palette from the View menu.

2. Seled the new Goto Screan button byclickingit.

3. Click cyan onthe battom row of the color palette to change the
badkgroundcolor. The button changes color. Now choaose white
from the top row as the foregroundcolor. The text changes to
white.

Assigning a Screen to the Button

Undo Chrl+2Z . .

Redn EE,W Finally, youmust configure the button to cdl upthe Report screen.
Cut Crl4 .

gﬁ;w Ct:I+E To assign a screen to the Goto Screen button:

Pasth Chrly

Ezfﬂith Cantiols ' 1. Seled the button. Choase Configure Screen Objed from the Edit
LT G B menu o from the toolbar. You cen also placethe painter on
Select Al Clikeas oos

upleste op the objea and click the right mouse button, a double-dick.
b= The Configure Screen Seled Button dalog boxappears. Here
;‘:{kg'i::fgefauns you assign the appropriate screen to the button.

-:-gfigure Screen Object...

Pozitian... Chrl+0

Canyvert o Wwalpaper

Wrilock Wallpaper,

Import/Expart Graphic 3
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You can also type a description d the button. This helps you
identify the ojed when youcrede reports. You can enter a name
of upto 15charaders. When youassign a nameto an oljed, you
increase the applicaion’s size by ore byte per charader.

Configqure Screen Select Button H
MName : I
Button Type :  |[ETTAYTEpaY - S - | | cancel |
Goto Screen - [i INITIAL SCREEN <] | hew |
Function Key : I j

2. Inthe Namefield, typegoto reports.

In the Button Type field youcan seled whether youwant to
crede a Goto Screen button a a Return to Previous Screen
button. Since Goto Screen is seleded by cefault, you do no need
to make any changes here

In the Goto Screen field seled the screen youwant to assignto
the button.

3. Click the arrow beside the Goto Screen field. From the
drop-down list, seled 50 Report.

If youarecreding applicaions for a keypad temminal, youmust
also assgn afunction key.

4. Click the arrow beside the Function Key field. From the
drop-down list, selea 12.

5. Choose OK to accept the changes.
6. Closethe dialog box.

You have creded and configured your first application screen oljed.
Now you must crede the seaond Goto Screen butonto cdl upthe
Alam History screen.
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Creating and Configuring
the Second Goto Screen

Button
Urdo Chl+Z
Eedo [Chil+v"
Cut Chrl+
Copy Chrl+C
Faste Chrl+4
Copy with Caontrals
Join Line Ends
Select Al Crl+&
Duplicate Chrl+D
Delete Dl
Clear All
Make Label
Set Object Defaults
Configure Screen Object...
Fozitian... Chrl+0

Conwert boWallpaper
nlock Wallpaper

Import/E #port Graphic
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Whenever youwant to crede an oljed that’s similar to existing
objeds, youcan use the Duplicate feaure. This makes a copy d an
existing oljed, which youcan then configure as necessary.

To create the second Goto Screen button:
1. Seled any existing Goto Screen button.

2. Choase Duplicate from the Edit menu o from the toolbar.
Or presscTrL+D.

A seaond buton appears, identicd to the first, bu slightly off set
from the original. You must configure this buttonto cal upthe
Alam History screan. Foll ow the steps you wsed previously, and
dothe following:

W positionthe button in the appropriate screen locétion

W delete the button's text, and label the button Al ar s

w configure the button to cdl upthe Alam History screen (255),
and changeits nameto got o al ar ns

w if you applicaionis keypad, assgn F13.

When youarefinished, ensure that the buttons appearin the order
shown in the followingill ustration. Eadh screen in the applicaion
has the same order, so it is important that you stay consistent in this
screan. You may need to rearrange some of the buttons. Follow the
steps described in the previous sedion.

etup Jiew lepor JEVTE
Fig Fil F12 Fi3




Creating Buttons and Importing Graphics 7-9

Adding a Graphic Image

(B ]
ek Burees
| Panh] Mot 1
Jud i abass ®|
PNERLE #|
| Treesl
D b |
| Tiees dad Qute &
| AT i =
Soedling Lird
3 pmied
Prmal pessags Hvgdey
| ASCH Dl pley
: iZein Cper Hads

| Sowen Frim Mg

| Dremwam =T s e
[ T o T |

Select one or more graphic images to import HER
File name: Faolders:
chabiphl400ekimagesisa
|
AGITATR.EMP i’ E oy =]

AGITATELEMP == AB
BLOWWER:.BMP & PB1400E
BLOWERL.BMP = MAGES
COMPRSR.EMP B 154
COMPRZRL.EMP
CONYEYR.BMP
CONWEYRL BMP =l =
Listfiles of type: Drives:
IWindows Bitmaps (*bmp) J I EHc J

You may find that the Initial Screen looks alittl e baring. To liven up
its appearance, youwill add a graphic image.

To add a graphic image:

1. Chocse Grgphic Image from the Objeds menu, and click Bitmap
Image.

The Seled Bitmap Image dialog boxappeass. This dialog box
displaysall the imagesin the applicaion's graphic image library.
Currently, the library contains noimages. You can use this dialog
box to import bitmap graphic images.

(Salect Bitmap fmage
Cimni hamap imagne . —,i

2. Click Import.

The Seled one or more graphic images to import dialog box
appeas.
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7-10 Creating Buttons and Importing Graphics

3. Choose the PB140E\TUTORIAL diredory. Seled copier.bmp
and choose OK.

The Seled Bitmap Image dialog boxregpeass, with the image
seleded. An ouline of theimage is displayed in the battom half
of the dialog box.

4. Click OK.

The small squareat the base of the panterindicates that the
objed tod is adive.

5. Positionthe painterwhereyouwant to placetheimage. While
haolding dovn the left mouse button, move the mouse.

6. Theimage appeass onthe screen. Positionit in the appropriate
location.

When the screen looks like the followingill ustration, youare
finished.

tmivl - KLG- FUTOH

KODIAK man =

Dhuplicator

1]
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Exiting the Initial Screen You have finished making changes to the Initial Screen. You can
now exit it.

To exit the screen:

Choase Close from the Screen menu, @ preSSCTRL+F4.

This automaticaly updates the screen.

Saving the Application To save your changes pemanently, save the application.

To save the application:

1. If the ApplicaionWindow is na drealy adive, click it or chocse

from the toolbar.

2. Choose Save Applicaion from the File menu a E from the
todlbar, or presscTRL+S.

If you do no have time to continue the tutorial now, close
PanelBuilder. If youwant to continue, go onto Chapter 8.

To close PanelBuilder:

Choaose Exit from the File menu, pressaLT-rF4, or doulde-dick the
control box.
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Chipter 8

Creating Control List Selectors
and Tags

This chapter shows you hav to crede and configure the Control List
Seledor withou Enter Key objed in the Setup&Printing screen. It
also shows you haw to crede and assign atag.

Creating and Configuring When the application s running, youcan use a Control List Seledor
the Control List Selector withou Enter Key objed to choase whether or nat youwant your
without Enter Key documents stapled.

Before youcan crede the ohjed, youmust open the Setup&Printing
screen from the Application Window. SeeChapter 6 if you reed help

openingit.

Sereens - KC-TUTOR - 10 SETUP&PRINTING * [_ O] x|
KODIAK Duplicatop—Setup Screem————

MM/ DD/ Y Y==HH: MM: SS_PH=

:—Cupg—l —Zoo —Staple— —Cl—
- \
Rese
Cancel

-—Copies

e M 5D e by
xF QO =0 =

—_— =
m A0 X—3 =

s o+ -

Setup Uiew
Fi@ Fil

Report filarms
Fi2 Fi3
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To create the Control List Selector without Enter K ey object:

1. Choaose Control Seledors from the Objeds menu and chocse

Control List Selecor without Enter Key, or chocse Iﬂ from
the toalbox.

+ Select
Push Buttons [ 2
Control Selectors Control List Selector with Enter Key
Indicators Control List Selector without Enter Key
Numerics
Trend
Bar Graphs
Time and Date
ASCIH Input
Scrolling List
Symbol...
Local Message Display
ASCII Display
Goto Configure Mode

Set Bit Cursor Point

v v wv

Screen Selectors [ 3
Screen Print Button

Graphic Image 4
Drawings »
Text Ctri+T

Draw the Control List Seledor anywhereon you screen.

The Control List Seledor without Enter Key consistsof a list
comporent, an Up Cursor button, and a Down Cursor button. The
Control List Seledor withou Enter Key appeassin its default size
and format, with spacefor five possble chaices (states).

N

List

Five states

Up and Down
Cursor buttons
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Editing the Control List Selector without Enter Key

The Control List Seledor withou Enter Key has five states by
default. Eadh stateis indicaed byan arrow (" ). Because the user
will have only two choicesfor stapling (Yes and No), your list
requires ony two states. Change the number of states by resizing the
list.

To edit the Control List Selector without Enter Key
1. Click the obed to seled it.

2. Positionthe painter overthe list comporent in the Control List
Seledor objed and click again. The secondclick seledsthe
comporent (in this case the list comporent). The hadlow handles
show that an oljed comporent, na an entire objed, is seleded.

3. Resizethe list comporent verticdly urtil it shows only two states
(Height 56). Follow the stepsin Chapter 7 if you reed help
resizing.

4. Resizethelist horizontally so that you can fit it inside the Staple
outline box (Width 65).

" Tip: Resizethelist diagorelly by seleding ore of the corner
handes. This combines steps 3 and 4into ore step.

5. Move the list comporent into the Staple outline box.

6. Addtext to the two statesin the list. The first state shoud read
[ No. To move the text cursor from the first to the second state,
pressenTeR. The secondstate shoud read Yes.

7. Seled the Down Cursor button d the ojed. The status bar tells
youwhich buton you fave seleded. Resizethe button to Width
64, Height 80. Position the button in the Staple otline box.
Because youwill be disabling the Up Cursor buttonlater, you do
not neal to move or resizeit.

8. Add hitmap images to the Down Cursor butonto clarify its
functionto the operaor. Import these two graphic images from
the C:\AB\PB140(E\IMAGESVWRROWS diredory:

W arrowdn.lmp
W arrowup.bmp

" Note: Youcan import bath images at once In the Seled one or
more graphic images to import dialog box,seled ore of the
images, then presscTrL while youseled the secondimage.
Choase OK, and bah appearin the graphic library.
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8-4 Creating Control List Selectors and Tags

9. Placeeadimage diredly onthe button, as shown. SeeChapter 7
for information onimporting and dawing gaphic images.

10. Afteryou have added the arrows, seled ead arrow and chocse
Make Label from the Edit menu. This associates the image with
the obed. If MakeLabel appeats dimmed, PanelBuil der
automaticaly made the graphic image into alabel when you
placel it. The handles for theimage arehdlow if it is alabel.

11. Sinceyouwill beassgning afunction key to this button, add the
following text: F16

12. Seled the ohjed and change the appearance of the ohjed to
match the remaining oljeds onthe screan. Make the following
changes:

A. Change the colorsto yellow on dark blue.

B. Seled thelist comporent by clicking it twice and chocse
Inset 4 as Border Style in the Format menu.

C. Seled the down buton byclickingit twice and chocse
Raised 2 as Border Style.

When youarefinished, the Control List Seledor without Enter
Key shoud look similar to the followingill ustration.

Keypad Touch Screen
—Staple— —Staple—

Now you arerealy to configure the Control List Seledor withou
Enter Key.
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Configuring the Control List Selector without Enter Key

To configure the Control List Selector without Ente  r Key:
1. Seled theentire objed. Choase Configure Screen Objed from
the Edit menu a from the todbar. You can also placethe
(] 8

pointer onthe oljed and click the right mouse button, o
doule-dick.

The Configure Control List Seledor dialog boxappeass.

2. Inthe Namefield, type St apl er. This description d the
objed’sfunctionis useful if youwant to dacument the
applicationin areport.

Sincethe Control List Type field is arealy set to Control List
Seledor without Enter Key, you do no need to change this field.

The Initial State field determines the state that the objed is set to
when the screen is displayed. The stapling ogion has two states:
0 (No) and 1(Yes). Becaise you do no want stapling as the
default, accept the value of O inthe Initial State field.

Tip: Youcan change the states' default values (0 and 1) to ather
numbers. However, for this example, these values areappropriate.
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Youwill naticetwo timing paraneter fields: Auto-Reped Rate
and Auto-Reped Start Delay. By default, the Auto-Reped field
has avalue of 0. This meansthat it is disabled. If the buttonis
held davn, it will nat gointo repea mode. For this applicdion,
the defaults areappropriate.

The Up Cursor and Down Cursor fields determine which cursor
buttons appearonthe screen. You can remove eitherthe Up o
Down cursor button from the screen, bu na bath. You do no
need bah cursor buttons for alist with oy two states.

3. Click the Up Cursor Enabled box.The x disappears, indicaing
that the cursor button is now disabled.

4. If you have a keypad application, assgn Fie6 to the Down Cursor.

You arenow ready to configure the Selecor Control.

Creating the Selector Control

When youconverted the PanelB uil der 1200application, al existing
addresses wereautomaticaly converted into tags. The tags arestored
in the tag database. Ead control ohed, window, or PLC 1/O Control
option hes one or more tags assgned. In turn, ead tag has an
addressonthe PLC. Some control ojeds, windovsand PLC 1/O
Control options also alow youto use expressons to perform
mathematicd cdculations, logic, or condtional logic operdions on
the output from one or more tags. For more information abou tags,
the tag database, and expressons, referto the PanelBuilder 140G
Configuration Sdtware for Windowvs User Manud.

You must crede a newtag for the Control List Seledor. You can then
assignthis tag as the Seledor Control.

Credethetag in the Tag Database editor. Therearetwo ways of
accessing the Tag Database editor:

W throughthe System folderin the Application Window
w throughan ojed’s configuration dalog box

In this case, youwill accessthe Tag Editor throughthe ojed’s
configuration dalog box.
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87

To access the Tag Editor:

1. Inthe Configure Control List Seledor dialog box,choose Assign

Tag.

The Tag Browser dialog boxappeass. In the Folders sedion there
is asingle folder that contains al the application tags.

If youwanted to use an existingtag, youcoud chocse a tag from
one of the folders. However, for this ojed youwill want to

crede a newtag.

Fiilrman Torgm: _
|= | Teay OIFI_B_1_Diy - ey
':-Q'i':':'_l-'n'l_.r = | I
:ur_a i 'll."‘ Ty _-E 1
2] | .I .IE 7 _Cha
:,_:1 :I '[I 11_Ein
Tmn 4D Y_4-7 6 _INr
o DIDG T 0 .' Bin
T MES 7 A ey | Edil Thu |
'1.-._-_1| :_'_ Ll -;
:-L._,_ I:I:| _‘3"
'lr_dlll_._l-\._._-jn
Ty D001 304 11_Bin bierw Einlibes
T 01 012111 _Bin
T T 9 141 15 Fan i
i I o [ flrks of | [ comim |

2. Choose New Tag.

The Tag Editor appeas.
T |
Tt
Nares: | ppee.| =l 1
e (=]
[ ]
hwta Giajp=te
Tree T Owwica 5 000 T ey Bomie i) T Schedibd FTr T T
F|'..| |
Sl ait

You arerealy to crede the newtag.
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To create the new tag:

1
2.

The cursor isin the Name field. Type St apl er _But t on.

Click the arrow beside the Type field and chocse Digital from the
drop-down list. Usualy youwould choose Analog for Control
List Seledors, but because this Control List Seledor has ony two
values, chocse Digital. A digital tag can acoommodate only the
valuesOand 1.

You do no neead to change any o the default values in the editor,
except for the address In the Addressfield youmust enter the
PL C addressfor this tag. (In a new appli cation youwould have to
define the radk and word definitions, but because this file was
conwerted, youcan use the existing cefinitions.)

Doube-dick the default addressin the Addressfield to highlight
it, then typei : 032/ 10.

The values are
This value Means this
i Input
03 Rack 3
2 Word 2
/10 10th Bit
Choaose Accept.

The Tag Editor closes and the Tag Browser regppeass. The tag
youjustcreded is seleded automaticdly.

Choase OK in the Tag Browserto assgnthe tag. The tag appeais
to theright of the Seledor Control in the Configure Control List
Seledor dialog box.

Choase OK again in the Configure Cortrol List Seledor dialog
boxto accept the changes and close the dialog box.

Thetag is assgned.
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Validating the Screen

[ =TT ClrlsN
Closs Ctrierd

Seren Seltings...
Sergen Securiby..

Soereen Tag Usage Viewsr Fh
Epil

The Vali date feature helps you identify any problemsin the screen,
such as overapping oheds. When you tave finished editing the
screan, youshoud validate it.

To validate the screen:

Choose Screen Validate from the Screen menu a pressro.

The Validation Results for Screens window appeas. If thereare
any errors or problemsin the screan, it lists them. The screen
validation boxshown below indicaesthat the screen is error-free

VS Walidntien Resolts lid Seriens - KC-TUTOR - 10 SETUPSPRINTING REE

Toinl sumber of mime - 8 .,,£ ;
!ﬁ
T Ty e
Tage [F0 AT L EIM- |
Friva Bemp___ |
bep |

IJ t "

If thereareany errors, fix them and revalidate the screen urtil there
arenoerrors. Then youarerealy to exit and save the application.

Tip: Leave the Validation Results window open on you desktop
while youaremaking the necessary changes to the screen. You may
want to resizethe window and move it slightly off screen. When you
have made a corredion, choose Update onthe Validation Results
window. This will ched the changes you have made. If youwant,
you can print the Validation Results window.
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I
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Viewing the Tag Usage for the Screen

Before youexit the screen, look at the tags assigned to oljedsin the
screa. You can dothis with the Screen Tag Usage Viewer

To open the Screen Tag Usage Viewer:

1. Choose Screen Tag Usage Viewerfrom the Screen menu a
pressrs.

The Tag Usage Viewerfor Screens appeass. It shows all the tags
that areconfigured for objedsin this screen. You can seard,
filter, adjust the column widths, and grint the listing.

2. Lookfor thetag youjustcreded. Youwill findit in Row 16.Tags
aresorted alphanumericaly acording to whether they arelnpu
or Output, and acording to their address
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Exiting the Screen
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To exit the Setup&Printing screen, choose Closein the Screen menu
or in the Control boxmenu, a doulde-dick the screen window’s
control box, @ presscTRL+F4.

To ensure that you do nolose your changes, save you applicationto
disk. Chocse Save Applicdionin the File menu a . from the
toolbar.



Chipter 9

Creating and Configuring
Multistate Indicators

Creating Multistate Indicators
and Drawing Lines

This chapter shows you hav to add two Multistate Indicator ojeds
to the Copier Overview screen.

Open the Copier Overview screan. The copierill ustrationis aline
objed that contains twelve Multistate Indicaor objeds and two bar

graphs.

Sereens - KC-TUTOR - 40 COPIER OVERVIEW* - 0] x]

i efup View Repor ilarms
Fid Fii Fi2 Fi3

KODIAK Duplicatop—————(yeryiew Screep=—

Feeder Top Ex1t Finisher

r rK

‘ n n/a n/a

Upper Bin} Full rll-l
Lower Bin Fulll-b. n/a

Printer

Ead Multistate Indicator displays the status of a cettain areain the
machine. For example, if thereis a paperjam in the finisher area the
Multistate Indicator in the finisher areashows Jam. If this areain the
madhine is functioning propeny, the Multistate Indicaor shows OK.
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Presfous State AP
Grid Settings...
Zoom "
Foom Qut
¢ Shovw Cobor Palette
 Sherwe o0l
State: |2 +
1]
q
3
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Viewing the States of a Multistate Indicator

Asan example of this, look at the four states of the Printer ojed.

To view the four states:

1

Seled the Printer Multistate Indicaor objed in the copier (not the
label that is outside the copier). By default, this objed is at State O.

n/a ———— Select this object

Printer

Choaose Next State from the View menu a preSSALT +N.

Tip: To move from one state to any ather state, youcan also use
the State field in the todlbar. Seled the ohjed, click State in the
todbar, and chocse the state you want to move to from the
drop-down list. To move throughthe states using a keyboard
shortcut, presscTrL+sHIFT+s. While hdding dovn these keys,
pressthe upand davn arrow keysto move throughthe states.

The ojed changesto blue onwhite, with state text “Ok.” It is
now at State 1.

Note: The status bartells youthe current state of the ojed if the
pointer is positioned onthe screen.

Move throughthe remaining states, urtil youarrive badk at State 0.

0k Toner (TN

Now seled the Printer Multistate Indicator ojed ouside the
copier, and view its four states. Youwill seethat its states' colors
match those of the Printer Multistate Indicaor objed in the
copier.

Isglnt3s Printer Printer [39liliay
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These arethe meanings of the states:

w State O—the printeris nat adive and thereareno goblems
w State 1—the printeris adive and thereareno poblems

w State 2—the printeris adive, bu the toneris runnng low.
This is awaming state.

W State 3—the printer has a paper jam

Adding the Stapler Multistate Indicator

Thereis an empty areain the existing ill ustration. This is wherethe
stapleris locaed in the new madine.

To show the stapler’slocaion, dawtwo Multistate Indicator
objeds—oreinside the copier drawing, and ore ouside the drawing.
Corfigure ead of these to show four different states.

To draw the first Multistate Indicator:

1. Chocse Indicators from the Objeds menu and chocse Multistate.
Or choose from the toolbox.

2. Positionthe mouse painterinside the blank areain the copier and
draw the Multistate Indicator.

It appeassinits default size, with default colors.

Tip: If the obed’s badgroundcolor is the same color as the
screan, change the oljed’s color temporarily to make it essier to
see

3. Seled the Multistate Indicaor, choose Border Style from the
Format menu, and seled Nore.

4. Resizethe new Multistate Indicator so it is the same sizeas the
existing Multistate Indicaors (Width 40,Height 20).

5. Positionthe Multistate Indicaor so it appeass asin the following
illustration.
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n/a

Ok
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Feedep Top Exit Finisher
! ] !
L_ n/a L] n/a n/a
Full
lppen Big |
| [
Lower Bin n/a =
/

—/
Printer /

New Multistate Indicator

Now you can configure the states.

Configuring the States

Unlessyou have set different defaults for the Multistate Indicator,
the new Multistate Indicaor automaticdly has four states assgned.
By default, it is at State 0. This is the state that appeas when the
copieris na adive, andthereareno poblems.

To configure these states:
1. Configure State 0 asfollows:

A. Seled the objed. Change the foregroundcolor to light grey
and the badgroundcolor to bue.

B. Credethetext label n/ a for “not adive.”

You have defined the first state (State 0) of the ohjed. Now you
can configure the remaining states.

2. With the objed (but nat the text) seleded, chocse Next State from
the View menu a pressaLT+N. The obed is now at State 1.

3. Configure State 1 as follows:

A. Crede thelabel OK to indicate that everythingis functioning
corredly.

B. Change the foregroundcolor to biue and the badkground
color to white.
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Note: Make sure you gacethe I-beam inside the objed’s

redangle. Otherwise, youmust reposition the text and chocse
Make Label from the Edit menu.

Ll]lil 4. Configure State 2 as follows:
A. Creaethelabel Lowfor “Staple Supdy Low.”
B. Changethe foregroundcolor to Had and the badkground
color to yellow.
5. Configure State 3 asfollows:
Jam ?

A. Credethelabel Jamfor “ Stapler Jam.”

B. Change the foregroundcolor to white and the bacdkground
color to red.

When you rave defined the four states, youcan configure the tag.
Configuring the Multistate I ndicator

To configure the Multistate Indicator:

1. Seled the objed. Choase Configure Screen Objed... from the
Edit menu o on the todlbar.

The Configure Multistate Indicaor dialog boxappeass.
2. Inthe Namefield, type St apl er.

s =]
| oesee |
Hoagharai e B o]
[ _tww |

| tewgn oy || semgeiapn | | vesesgn |

Youwill naticethat you can spedfy the objed’s number of states
in this dialog box.The default numberis four. Because this is the
number of states youwant, youwill nat need to change it.
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3. Choose Edit States.

The Configure State Values dialog boxappeass. If youwanted to,
you could assign dfferent values to the states. In this case, accept
the defaults.

Configure State Values H

Jtate

Srate Value —Spreadsheet Operations —

Clear

Cut

Copy

Paste

RBenumber

Enter a unique value from -2147483648 to 2147483647,
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4. Choose OK.

The Configure Multistate Indicator dialog boxregppears. You can
now assign the control, which can be atag or an expression. For
the purposes of this tutorial, assign atag.

To assign the Indicator State:
1. Choose AssgnTag.
2. The Tag Browser appeass.
You must crede a newtag for this objed.
3. Choose New Tag.

SeeChapter 8 for information about creding rewtags. Creae
and assgn the tag shown in the following ill ustration. This time
youwill want to use an analog tag because the values range from
0to 4.For the address use the one shown, a assign any hinary
output addressusing threehits.
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Tag Editor

‘Tag

Name: ISlillJ|ﬂl_|"dit=iltﬂl T}-pe:lhnalug J Sec:uril_-,v:lx JJ

Deszcription: I

Minimum: II]

Scale: |1 Unitsz: I Dizcard

Maximum: |1 oo

Dffset: ||] Data Type: IBinaly jJ

Initial ¥alue: |u

"l )

rData Source

Type: () Device ) DDE O Memory @ Remote 1/0 ) Scheduled

[ LogData

™ (Atam.. |

Address: |i:l]33!l] -31

Adding the Second Stapler Multistate Indicator

The second Multistate Indicaor is outside the copier drawing. It also
must have four states that correspondto those of the first ojed.

1

Crede the Multistate Indicator objed and paitionit onthe
screan, ouside of the copier ill ustration.

If youwish, youcan seled an existing Multistate Indicator objed,
and wse the Duplicae command. Then youcan edit the new
objed so that the text reads St apl er in ead state.

Or youcan drawthe objed, foll owing the steps described
previously, and define ead state separaely.

Finisher

!
n/a

Staplep
n/a
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2.

You do no have to crede a new tag for this Multistate Indicator.
Because it is designed to operae in tandem with the other
Multistate Indicator, youcan assgn the same tag to bah oljeds.

To assgn the tag, open the Configure Multistate Indicator dialog
box and chocse Assgn Tag. Seled the Stapler_Indicator tag in
the Tag Browser, and choose OK.

Drawing Lines and Arrows

To keep the appearance of the new objeds consisent with the
remaining oljeds, add aline and arrow painting to the Multistate
Indcator in the copier.

To draw a line:

1

Seled ore of the existing linesin the drawing. By daing this, you
ensure that the next time you daw lines, the new line defaults
will be the same as the existing lines.

Choase Drawings from the Objeds menu and then chocse Line.
Or, choose| N from the toolbox.

Note that the painter now hasasmall line at its base. This means
thelinetod is adive.

Pressthe left mouse button. While hdding the button, dag the
mouse. A line appeass. When it is the right size, release the
mouse button.

Tip: Tocredeahaizonta line, hdd down the sHIFT key as you
aredrawing the line.

Position the line next to the stapler Multistate Indicaor ojed in
the copier.

If youwish, conred the harizontal line to the outside Stapler
Multistate Indicator objed by drawing adiagoral line.

Now you can add an arrow to the line so it pants to the Multistate
Indcator in the copier.



Creating Multistate Indicators and Drawing Lines 9-9

Validating the Screen and
Saving the Application

To add an arrow:

1. Follow the steps for importing a graphic image, and import
arrowlf.bmp from the C\AB\PB140(E\IMAGES\ARROWS
diredory.

2. Placethe arrow onthe screen, and paitionit at the left end o the
line.

3. Change the arrow’s colors to match those of the line.

When youarefinished, you staplerill ustration shoud look
something like this.

Finisher

n/a

Stapler

n/a <—

When you tave finished finetuning the design, vali date the screen,
as described in Chapter 8.

Fix all problemsin the screen and revalidate it to ensure thereareno
further problems Then close the screen, and save the applicaion.
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Adding Alarm Messages
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Creating Alarm Messages

This chapter shows you hav to add alamm messages to your
applicaion.

At this paint you heve added al the objedsrequired to be ableto use
the stapler option when the applicationis running. However, youstill
neal to add alarm messages that will inform youwhen something
goeswrongwith the stapler.

Add alatmm messagesin the Alarm Messages editor.

To open the Alarm Messages editor:
1. Open the Messages folder in the Application Window.

2. Choose the Alam Messages editor, or chocse from the
toolbar.

The Alam Messages spreadshed appeais on you screan. There
areadrealy seven messages.

b =

L]

iy

4]

-]

=1

-]

LY ]

=1 R b b

B

- KC-TUTOR

Audio |Print [Disvlau |[Relau |[Msa To PLC |Messadae -
H Y H N Document Feeder — Paper Misfeed —
H L' H Top Exit — Jam |-
| ¥ | M Finisher — Jan
H ¥ H H Paper Bin A - Paper low
H ¥ H H Paper Bin B - Paper low
H Y H N Copier — Paper Jam
H L' H H Copier — Toner Low

T T TZTIZ

-

To add the first new message:

1. Positionthe panter onthe Trigger Value field in row 8 and click,
or use the down arrow to move to row 8.

2. Although yowcan enter any pasitive or negative trigger value,
type 8.

AnN (for “N0”) appearsinthe Audio, Print, Relay, and Msg To
PLC fields. This means that these options arenat enabled. The
Display field showsaY (for “Yes’). This optionis therefore
enabled. Accept the option defaults.
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FHE N ]
9 |9 N ]
File

Update Messages Ctrl+U

Close Ctrl+F4

Import Message File...

Publication 2711E-6.13 — November 1998

3. Positionthe panterin the Message field in row 8 and click, or

use the TaB key to move to the field.

4. TypeStapler is out of staples
5. Inrow 9, enteratrigger value of 9 and add the foll owing

message: St apler is jamred

M N
M N

Starler is out of staples
Stapler is Jammed

When youarefinished, updite the messages.

To update the messages:

Choose Update Messages from the File menu o E from the
todbar, or presscTRL+U.

Note: The Message Editor automaticdly validates your messages
when you upéte them. If thereareany problems such as
dudicae message numbers, the Vali dation Results window
appeass, displaying dl the errors. Corred the errors and updite
your messages again.

When youarefinished, close the Alarm Messages editor and save
the application.

You arenow ready to download the applicaion.
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Validating the Application

Touols

Beports...

Yalidate

Change Network Type...
Application Size

Fa

Replace Tag Name...
Tag Usage Yiewer

Fb

Transfer Utility

Getting Ready to
Download

Downloading and Running the
Application

When you tave completed al the work, this chapter shows you hav
to validate your application. Then youcan download it to the
PanelView termina and runit. Validating you appli cation ensures it
is free of errors.

Your applicationis validated automaticaly beforeit can be
downloaded to a Panel View terminal. Validation chedks for errors,
including owerapped butons, objeds that areoff the screen, and so
on. You can also validate your applicaion manually at any time.

To validate your application:
1. Click the Application Window or chocse from the toadlbar.
2. Choose Validate from the Tods menu a pressro.

The Validation Results window appeass. It lists any errors
present.

If thereareerrors, go kad to the screen ar message editor and
corred the errors.

When therearenoerrors, youarerealy to dovnload.

You may have naticed that the AB\PB140E\TUTORIAL diredory
contains existing *.pwvc files. These fil es areappli cations that have
been completed acording to the instructions in the tutorial and are
ready to be downloaded.

If youwish, youcan download the file you have just creded. Before
you do,make sure you save it. However, if you have deviated from
the tutorial, your file may nat work with the PLC ladder logic that
comes with the tutorial. We therefore recommend that you wse one of
the existing tutorial files.

To dowvnload an existing tutorial file, youmust open the appropriate
application:

W tutork.pvc—for keypad temminals

W tutort.pvc—for touch screen teminals

To open the appropriate applicaion, follow the instructionsin
Chapter 4. Because these are*.pvc applications, you do no need to
change the List Files of Typefield.
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Running the Application
File
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You can use the PanelView e File Transfer Utility 32installed ona
portable computer to download ateminal file (*.pvd) to a
Panel View terminal at aremote locaion. If you doso, you do no
need to open the applicaionin PanelBuilder. Seethe PanelView e
Transfer Utility User Manud for more information.

Downloading the App lication

PanelB uil der 140Qe provides severd methods for downloading you
application. Referto the Panel View e Transfer Utility User Manud
for step-by-step instructions on davnloading. After you have
downloaded the appli caion, return to this tutorial.

If you have downloaded afile and spedfied it to be the Current
Applicaion, switching the PanelView temmina to Run mode will run
that file. If you dd na spedfy that the downloaded file is to be the
Current Applicaion and thereareother applications onthe terminal,
youwill need to goto the Seled Applicaion screen with the
Panel View terminal in Configure mode, to make it current. Seethe
PandView 100G, 120G, and 140@ Operator Terminals User
Manud for information about the termina’s Configure Mode.

Tip: To explore the phaocopier applicaion fully, conrned the
PanelView terminal to a PLC that is loaded with the PanelB uil der
tutorial ladder logic. The ladderlogic files (TUTORIAL .*) arein the
\AB\PB140(E\TUTORIAL diredory, onthe drive onwhich you
install ed PanelBuil der.

To run the application:
1. Set the PanelViewterminal to Run mode.
You seethe Initia Screen.

2. Pressore of the Goto Screen butons or the correspondng
function key.

The assigned screen appeass.

3. Explore the application. Test the different oljedsto seehow they
work. In the applicaion’s Setup screen, try copying lamge
quantities. Then look at the Copier Overview screen to seehow
the Multistate Indicaors and Bar Grgphs work.

If necessary, referbadk to Chapter 4 for information onthe different
objeds and hav they work.
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Exiting the Tutorial
Mew Application... Ctri+N
Open Application... Ctrl+0
Sawve Application Ctri+5
Sawve Application As...

Close Ctrl+F4
Download...

Upload...

Exit Alt+F4

Note: Youcan modify the ladderlogic onthe PLC using
Allen-Bradley programming tools. Referto the documentation that
comes with you programming softwarefor instructions. Before you
make changes however, make a badkup copy d the ladder logic!

Application Design Features

Asyouaremoving throughthe screens, ndicethe design feaures of

this application.

w Consstency—Buttons and screen titl es are positioned
consisently aciossthe different applicaion screans.

w Screen Navigation—The screens areeasy to navigate. You can
cdl upany screen from anywherein the application.

W Colors—The screans provide optimum contrast for readability.

Colorswith associated meanings areapplied to cettain oljeds.
For example, in the Setup&Printing screen, the Print buttonis
green; the Cancd buttonis red.

In Multistate Indicaors, colors for ead state areconfigured to
conwey the appropriate meaning. For example, State 0 (nat adive)
is blue. State 3 (error) is red to dert the user.

w Control Groups—Groups of controls arearranged left to right,
topto batom, in the order they would logicdly be used.

For example, inpu options arearranged as foll ows:
Copies; Paper Source; Copy Quality/Mode; Zoom.

w Button Placement—On keypad appli caions, ead Goto Screen
buttonis placel nearthe function key that controls it.

When youarefinished exploring the Copier application, youcan exit
the applicaion running onthe PanelViewteminal by turning the
terminal off. You can also exit PanelBuilder 140Ce.

To exit PanelBuilder 1400e:

Choose Exit from the File menu, doulbe-dick in the Control box,
OF PreSSALT +F4.

You have completed the tutorial. Youarenow realy to begin
designing you own applications.

Congratulations on chocsing PanelB uil der 140Ce.
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Numbers
24-hour support, P-7

A

Active
applications, 5-15
editors, 5-15
screens, 5-15
window, 5-14
Adding graphic images, 7-8
Alarm screens
about, 5-7

alarm history screen, about, 5-7
alarm status screen, about, 5-7

Alarms, creating, 10-1

Application File Transfer equipment,
application file transfer, 2-2

Application screens, about, 1-3
See also Screens

Application Window
about, 5-4
editors, starting, 5-11
folders, about, 5-6
icons, using, 5-17
keys, using, 5-17
menus, using, 5-17
tabs, using in dialog boxes, 5-11
using, 5-9
working in, 5-11
Applications
about, 5-4
closing, 5-21
converting, 5-2
designing, 11-3
existing, opening, 5-2
multiple, arranging, 5-15
new, creating, 5-1
opening, P-6
saving, 7-11
working with multiple, 5-13

Arrows, drawing, 9-8
AUTOEXEC.BAT file, 3-4, 3-6, 3-8, 3-10
Available documentation, P-2

B

Border, using, 5-9
Buttons, creating, 7-1

C

CD-ROM, PanelBuilder
general information
creating floppy disks, 2-3, 2-11
operating system compatibility, 2-3
software applications contained, 2-3
install procedure, PanelBuilder
Version 3
Windows 3.1 or later, 2-8
Windows 95, 2-8
Version 5
Windows 95, 2-4
Windows NT, 2-4

Closing
applications, 5-21
editors, 5-21
Commands

control menu, 5-18
conventions, P-6

Communication drivers, SFU, 4-6

Configuration folder
global address options, 5-20
terminal setup, 5-20

Control box, using, 5-8
Control List Selectors, creating, 8-1

Control menu
commands, about, 5-18
using, 5-17

ControINet
about, 1-4
communicating, 1-2

Conventions
commands, P-6
dialog boxes, P-6
key, P-6
mouse, P-5
selection, P-5
shortcut keys, P-6
used in the manual, P-5
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Creating
buttons, 7-1
Control List Selectors, 8-1
new applications, 5-1
tags, 8-1

D

Data Highway Plus, about, 1-4

Dialog boxes
about, 5-6
conventions, P-6
tabs, using, 5-11

Documentation, P-2

Drawing
arrows, 9-8
lines, 9-8

Editors
about, 5-6
closing, 5-21
messages, 5-20
screens, 5-21
starting, 5-11
working with multiple, 5-13
Equipment
application file transfer, 2-2
optional, 2-2
Exiting
PanelBuilder 1400e, 5-21, 7-11
Tutorial, 11-3

Exiting from Serial Firmware Upgrade
Utility, 4-8

Exiting from Transfer Utility, 3-13

F

Floppy disks, PanelBuilder 1400e install

procedure

Version 3
Windows 3.1 or later, 2-13
Windows 95, 2-13

Version 5
Windows 95, 2-11
Windows NT, 2-11

Folders
about, 5-6
dialog boxes, 5-19
editors, 5-19

Messages folder, 5-20
about, 5-6
opening, 5-11
PLC Communications folder, 5-19
about, 5-6
Screens folder, 5-21
about, 5-6
System folder, 5-20
about, 5-6

G

Graphic images
adding, 7-8
resizing, P-7, 2-1

H

Hardware, requirements for running
PanelBuilder 1400e, 2-2

Help
See also Online Help
online, P-2

High Resolution, 5-1
Hot keys. See Shortcut keys

Icons
reducing windows to, 5-8
using, 5-17

Install procedure, PanelBuilder 1400e
CD-ROM
Version 3
Windows 3.1 or later, 2-8
Windows 95, 2-8
Version 5
Windows 95, 2-4
Windows NT, 2-4
floppy disks
Version 3
Windows 3.1 or later, 2-13
Windows 95, 2-13
Version 5
Windows 95, 2-11
Windows NT, 2-11
online manuals, 2-16

Installing FTU
CD-ROM
Windows 3.1 or later, 3-5
Windows 95, 3-5
Windows 95/NT, 3-2
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floppy disks
Windows 3.1 or later, 3-9
Windows 95, 3-9
Windows 95/NT, 3-7

Installing SFU
CD-ROM
Version 3
Windows 3.1 or later, 4-2
Windows 95, 4-2
Version 5
Windows 95, 4-1
Windows NT, 4-1
floppy disks
Version 3
Windows 3.1 or later, 4-5
Windows 95, 4-5
Version 5
Windows 95, 4-4
Windows NT, 4-4

INTERCHANGE. See software drivers
Internet, technical support services, P-7

K

Key conventions, P-6

Keys
shortcut, P-6
using, 5-17

L

Lines, drawing, 9-8

M

Maximizing
applications, 5-16
message editors, 5-16
PanelBuilder 1400e Window, 5-8
screens, 5-16

Menu, control, using, 5-17

Menu bar, using, 5-8, 5-9

Menus, using, 5-17

Message bar, using, 5-10
Messages, alarm messages, 10-1

Messages folder
about, 5-6
editors, 5-20

Minimizing
applications, to icons, 5-16
message editors, to icons, 5-16
PanelBuilder 1400e Window, 5-8
screens, to icons, 5-16

Modbus
learning PanelBuilder with, 6-1
using PanelView terminals with, 1-4

Mouse
conventions, P-5
multiple-button, P-5

Mouse pointer or cursor, using, 5-9
Moving, windows, 5-12

Multiple
application screens, working with, 5-13
applications
arranging, 5-15
working with, 5-13
editors, working with, 5-13
screens
arranging, 5-15
working with, 5-13
windows
arranging, 5-15
working with, 5-13

Multistate Indicators, creating, 9-1

N

Networks
ControlNet, 1-7
DH+, 1-6
Modbus, 1-4
RIO, 1-5

New PanelView Application dialog box, 5-1

0

Objects, types, 5-7
Online Help, P-2, 5-18
accessing, 5-18

Online manuals
installation, 2-16
viewing, 2-17

Opening
applications, P-6
existing applications, 5-2
folders, 5-11

Operator terminals, 1-2

Optional equipment, 2-2
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P

PanelBuilder 1400e
about, P-1, 1-1, 1-2
Application Window, using, 5-9
exiting, 5-21
install procedure
CD-ROM
Version 3
Windows 3.1 or later, 2-8
Windows 95, 2-8
Version 5
Windows 95, 2-4
Windows NT, 2-4
floppy disks
Version 3
Windows 3.1 or later, 2-13
Windows 95, 2-13
Version 5
Windows 95, 2-11
Windows NT, 2-11
key concepts, 5-4
alarm screens, 5-7
application screens, 5-7
Application Window, 5-4
applications, 5-4
dialog boxes, 5-6
editors, 5-6
folders, 5-6
objects, 5-7
PanelBuilder 1400e Window, 5-4
Tag Database, 5-7
windows, 5-7
new features, 1-8
quitting, 5-21
related publications, P-3
relationship between PanelBuilder 1400e,
PanelView terminals and PLC, 1-1
requirements, 2-1
requirements for running, 2-1
starting, 2-18
tour of, 5-1
uninstall, 2-19
Version 5 features, P-1
Window
about, 5-4
border, 5-9
control box, 5-8
elements, 5-8
maximizing, 5-8
menu bar, 5-8
minimizing, 5-8
mouse pointer or cursor, 5-9
restoring, 5-9
status bar, 5-9, 5-10
title bar, 5-8

toolbar, 5-8
working in, 5-8
PanelBuilder 1400e Window
menu bar, 5-9
toolbar, 5-9

PanelView 1200/1400e Transfer Utility
starting
from Windows 3.1 or later, 3-12
from Windows 95, 3-12
starting FTU, 3-12

PanelView e Transfer Utility 32
exiting, 3-13
starting, from Windows 3.1 or later, 3-11
starting FTU32, 3-11
PanelView terminals
about, 1-2
relationship between PanelBuilder 1400e,
PanelView terminals and PLC, 1-1
requirements for running PanelBuilder
1400e, 2-2
PLC
about, 1-4
relationship between PanelBuilder 1400e,
PanelView terminals and PLC, 1-1
PLC Communications folder
about, 5-6
dialog boxes, 5-19
editors, 5-19
Programmable logic controller. See PLC

Publications, relating to PanelBuilder
1400e, P-3

Q

Quitting, PanelBuilder 1400e, 5-21

R

Readme file, 2-18
about, P-2
printing, 2-18
reading, 2-18
README.TXT file. See Readme file

Reducing
applications, to icons, 5-16
message editors, to icons, 5-16
screens, to icons, 5-16

Registering PanelBuilder 1400e, P-1
Registration, software, P-1

Release notes, 2-18

Remote /O link, about, 1-4
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Requirements
for running PanelBuilder 1400e, 2-1
system, P-7
Resizing
graphic images, P-7
windows, 5-12

Resizing graphic images, 2-1

Restoring
applications, 5-16
message editors, 5-16
PanelBuilder 1400e Window, 5-9
screens, 5-16

RSLinx . See software drivers

S

Saving applications, 7-11

Screens
about, 5-7
application, about, 1-3
arranging multiple, 5-15
validating, 8-8
working with multiple, 5-13

Screens folder, 5-21
about, 5-6

Selection conventions, P-5

Serial Firmware Upgrade Utility
exiting, 4-8
install an additional driver, 4-6
installing from CD-ROM
Version 3
Windows 3.1 or later, 4-2
Windows 95, 4-2
Version 5
Windows 95, 4-1
Windows NT, 4-1
installing from floppy disks
Version 3
Windows 3.1 or later, 4-5
Windows 95, 4-5
Version 5
Windows 95, 4-4
Windows NT, 4-4
performing an upgrade, 4-7
starting, 4-7
from Windows, 4-7

Serial number, software, P-7
Shortcut keys, P-6

Software
registration, P-1
requirements for running PanelBuilder
1400¢, 2-1

software drivers
Version 3
INTERCHANGE, 2-4, 2-15
WINtelligent LINX, 2-4, 2-15
Version 5, RSLinx, 2-4, 2-13
Starting
editors, 5-11
Tutorial, 6-2
Starting PanelBuilder

Windows 3.1 or later, 2-19
Windows 95/NT, 2-18

Starting Serial Firmware Upgrade Utility
from Windows, 4-7
from Windows 95, 4-7
from Windows NT, 4-7

Starting Transfer Utility
from Windows 3.1 or later, 3-11, 3-12
from Windows 95, 3-12

Status bar, using, 5-9, 5-10
Support services, P-7

System folder
about, 5-6
dialog boxes, 5-20
editors, 5-20

System requirements, P-7
for PanelBuilder 1400e, 2-1

T

Tabs, dialog boxes, using, 5-11

Tag Database, about, 5-7

Tag usage, viewing for a screen, 8-9
Tags, creating, 8-1

Technical support services, P-7
Terminal windows, about, 5-7

Terminals
operator, 1-2
PanelView, 1-2
Terminology, defined, P-4
Title bar, using, 5-8
Toolbar, using, 5-8, 5-9
Transfer Utility
about, 1-1
exiting, 3-13
installing from CD-ROM
Version 3
Windows 3.1 or later, 3-5
Windows 95, 3-5
Version 5
Windows 95, 3-2
Windows NT, 3-2
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Index

installing from floppy disks
Version 3
Windows 3.1 or later, 3-9
Windows 95, 3-9
Version 5
Windows 95, 3-7
Windows NT, 3-7
starting, FTU, 3-12
starting FTU32, 3-11

Transferring, applications, 1-1
Troubleshooting, low resources, 5-3

Tutorial

application
design features, 11-3
downloading and running, 11-1
opening existing, 6-3
viewing screens, 6-4

exiting, 11-3

files, 6-3

for Modbus networks, 6-1

starting, 6-2

Uninstall
PanelBuilder 1400e, 2-19
Serial Firmware Upgrade Utility
SFU, 4-3, 4-6
SFU32, 4-2, 4-4
Transfer Utility
FTU, 3-7,3-10
FTU32, 3-5, 3-8
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Validating, screens, 8-8, 9-9

Version 3, PanelBuilder 1400e
install procedure
CD-ROM
Windows 3.1 or later, 2-8
Windows 95, 2-8
floppy disks
Windows 3.1 or later, 2-13
Windows 95, 2-13
software drivers
INTERCHANGE, 2-4, 2-15
WiNtelligent LINX, 2-4, 2-15

Version 5, PanelBuilder 1400e
install procedure
CD-ROM
Windows 95, 2-4
Windows NT, 2-4
floppy disks
Windows 95, 2-11
Windows NT, 2-11
software drivers, RSLinx, 2-4, 2-13

Viewing procedure, online manuals, 2-17
Viewing tag usage, 8-9

W

Windows
active, 5-14
cascading, 5-15
closing, 5-8
moving, 5-8, 5-12
resizing, 5-12
terminal, about, 5-7
tiling, 5-15
working with multiple, 5-13

WINtelligent LINX. See software drivers



‘l‘ Roclawell Aviomation Rockwell Automation helps its customers receive a superior returmn on their investment by bringing
together leading brands in industrial automation, creating a broad spectrum of easy-to-integrate
products. These are supported by local technical resources available worldwide, a global network
of system solutions providers, and the advanced technology resources of Rockwell.

Worldwide representation.
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Artisan Technology Group is an independent supplier of quality pre-owned equipment

Gold-standard solutions We buy equipment Learn more!

Extend the life of your critical industrial, Planning to,upgrade your/current Visit us at artisantg.com for more info
commercial, and military systems with our equipment? Have/surplus equipment taking on price quotes, drivers, technical

superior service and support. up’shelf'space? Well give'it a new home. specifications, manuals, and documentation.

Artisan Scientific Corporation dba Artisan Technology Group is not an affiliate, represéntative, or authorized distributor for any manufacturer listed herein.

(217) 352-9330 | sales@artisantg.com | artisantg.com TECHNOLOGY GROUP

We’re here to make your life easier. How can we help you today? Vl ARTISAN




